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1 STRUCTURE OF MANUAL 
This manual contains supplemental and methodological information on the BCS Editor radio 
journalist workstation intended for work in radio complexes structure of any degree 
of complexity. BCS Editor provides: 

• Recording and editing of reports, interviews, comments, thematic broadcasts and 
other types of audio material; 

• Production of commercials, musical and background noise effects of voice audio 
tracks; 

• Different types of processing, in particular, leveling and fades-in / fades out and 
processing by means of plug-ins; 

• Text handling: typing in the text of audio reports (stenography), conversion of a 
text into sound by recording of a material with the certain speed of reading; 

• Combined editing of text and sound: compositing of news blocks, compilation and 
packaging of broadcasts. 

BCS Editor works both in the structure of special hardware complexes of recording and 
editing, and as a standalone application; it can be installed in any room of radio station (for 
example, in editor’s office). 

BCS Editor works in a network configuration in structure of the automated complexes 
of preparation and broadcasting of DIGISPOT® II programs. 

BCS Editor runs under the operational system Microsoft Windows 2000 or Microsoft 
Windows XP (NTFS file system), minimal RAM requirement is 64 Mb for application only plus 
optimum requirements of OS. The required hard disk space depends on a final software 
configuration of broadcasting automation system DIGISPOT® II. Of course PC should have 
keyboard with the mouse and USB-ports. 

This manual describes functionalities of BCS Editor station in respect to ordinary tasks 
of preparation of programs. It is meant for technically competent persons possessing the 
basic skills of work with the keyboard and mouse in Windows environment. 

Section 2 is devoted to acquaintance with BCS Editor and discussion of some general 
concepts of work in the united text – sound field. Acquaintance with this section is 
necessary for understanding of other chapters of the manual and software product BCS 
Editor as a whole. 

Section 3 represents a detailed manual for starting work in BCS Editor program. In this 
section the technological chain of programs creation is discussed, in particular, points of 
project creation, types and technologies of editing, work with the clipboard and fragments 
buffer, saving of the project, etc. 

Section 4 contains supplemental information concerning option of various parameters 
of software product BCS Editor, in particular, option of properties of projects and subjects, 
presets of projects saving and options of the program itself are discussed. 
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2 BCS EDITOR IN DIGISPOT® II SYSTEM BASIC CONCEPTS 
 

The radio journalist workstation BCS Editor is intended for creation of different material for 
broadcasting, i.e. audio tracks, texts or their combinations (text - sound sequences). The 
prepared material is either entered in MDB DIGISPOT® II (further - MDB) or stored in file 
structure. 
It can be used from there by broadcasting station DIGISPOT® II DJin; besides, the material 
can get directly in the schedule of broadcasting station DJin from BCS Editor, passing 
storage stage 
in file structure or MDB. 

There are two basic concepts in BCS Editor: project and subject. Any work with a new 
material in this station begins with creation of the project. 

2.1 Project and subject 
The project is a set of audio material (audio files), text associated with it (text files), and 
also editing list file  specifying which files to play, from which positions and in which 
sequence, and, the main thing, at which audio levels. The project may contain one or 
several audio tracks. Tracks of the project are always stereophonic. 

The subject is a special type of the project existing as a separate substance in early 
versions of BCS Editor; it is the sequence of a text and audio material (audio files or 
projects). 

The user perceives the project as an integral audio track for broadcasting, and the 
subject - as text sequence with audio elements introduced into it; however for editing 
station BCS Editor these two concepts now are divided relatively enough. Broadcasting 
station perceives the project as a sound, and the subject as text sequence with audio tracks 
included in it. The information on the project is stored in a file with *.tpr extension; the 
information on the subject - in sbj file. 

The division of «subject» and «project» concepts is made only at a stage of storing of 
the collected material while working with BCS Editor. Different commands are used for 
storage 
of files as projects and subjects. 

Further in this manual we will talk only about projects, subjects will be mentioned only 
if the feature described is inherent only for them. 

2.2  Mixing and exporting 
Over any project in BCS Editor the certain set of operations can be performed, in particular, 
save, save as, normalization, etc. Note, that all material used in the project is stored in a 
file 
of the project - thus files of projects are self-sufficient, they can be copied from place to 
place on hard disk or over local network, sent by e-mail, etc. Work with the project can be 
finished 
by mixing operation. 

Mixing of the project (Save DB or FILE, Export) means creation of integrated audio file 
in wav or mp format. Mixing is carried out taking in account levels of segments, tracks, and 
also master-level of entire project. As a result of mixing the audio file is created which 
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further is used for broadcasting preparation or   directly for broadcasting. Mixing operation 
can be made with the help of commands Save to FILE and Save to DB of the main menu File 
with the certain settings or with the help of Export procedure. 

MDB and the schedule of broadcasting station perceives and plays back both projects, 
and the files received as a result of their mixing. However, in the view of the user there are 
a number of basic distinctions between the project and mixed file. The mixed project cannot 
be continued to edit; for modification it is necessary to create the new project and to import 
the mixed audio track there. 

NOTE 

Remember, that the text attached to audio is lost in mixing process. 

BCS Editor can work both with MDB DIGISPOT® II, and without it, only with folders and 
catalogues of file structure. It is necessary to imagine precisely, whence we can take the 
information for work in both mentioned cases. 

By the way, working with МDB there is always the opportunity to address directly to file 
structure, but working with file structure not always means the opportunity to address to 
MDB (all depends on a complete set of the DIGISPOT® II software). 

2.3 Elements of the project and accessible operations 

2.3.1 Audio Tracks 

Any project consists at least of one audio track. 

 

 

Fig. 2.1. Audio track 

The audio track is one stereo audio channel submitted as waveform on the screen of the 
monitor (fig. 2.1). 

NOTE 

In case of use of monophonic source the same signal is copied in the left and the right channels with 
an initial level. On the top part of waveform the amplitude of a signal in the left channel is displayed, and in 
bottom part of it – the amplitude of the right channel. 

The waveform consists of sequence of segments (in the simplest case there is only one 
segment). 
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BCS Editor does not limit the user in number of created audio tracks. Each track in the 
project has a state of selection, i.e. it can be selected or not selected. The selected (active) 
audio track is displayed in green background color, and not selected audio track – in grey 
color. Selection of audio track is possible with the left-click or right-click of the mouse on 
any point 
of a grey field (right button opens context menu, more detailed we consider it later in 
section 4). 

The program allows selection of several tracks simultaneously, using the left-click and 
Ctrl key. 

Cut and Copy operations work with audio on all marked tracks. Similarly as a result 
of Paste operation the audio track will be inserted in the first marked track from the 
clipboard. 

In case if some group of tracks is marked, in separate operations which are «able» to 
work only with only one marked track, active is considered the top of marked tracks. 
Operations, working only with one track are: recording of a signal, Place file, etc. 

During playback all tracks sound irrespective of selection and according to states 
of switches S (Solo) and M (Mute) on each of them (switches are located to the left of 
tracks; more detailed information concerning Solo and Mute modes will be given below). 
Operations 
of editing by markers are applied only to selected tracks. 

2.3.2 Segments and fades 

Each audio track consists of segments. 

 

 

Fig. 2.2. Segments 

Segment is a structural unit of audio editing (fig. 2.2). Each segment has adjustable 
length, fade-in and fade-out and also a level of mixing. 

Initially segments are formed at audio recording or at an inserting of audio fragments 
in the project. For example, record from a microphone («in one step»), an insert of a sound 
from a file on a hard disk or from the clipboard form a new segment. There can be unlimited 
number of segments. Segments can be overlapped, imposed one to another or not 
be transversal at all. 
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Except for the above described operations, new segments can be received by cutting 
already available segments. Frequently it happens conveniently to cut the track to segments 
on a content attribute. For example, interview with the visitor, recorded without breaks can 
be divided into segments containing questions of the presenter and answers of the 
interviewee. 

Smooth changing of segment level on an input and output refers to fade. The most 
important characteristic of the fade is its duration. In the beginning of the segment the sound 
level smoothly changes from 0 up to the value of the segment level – this is fade-in; in the 
end of a segment the level varies from value of the segment level to 0 – this is fade-out. 
It is possible to edit fades during general editing. 

Segments can be copied, deleted or moved on a track. Also they can be «shortened» 
both from the beginning, and from the end of them, pauses can be deleted, «aspirations» 
and other defects can be removed. All operations (including level adjustment, change of 
length, change 
of the beginning and the end, setting of fades, etc.) are applied only to an active segment. 
At the activated indication mode of segments, the active segment is marked with blue color. 

2.3.3 Record 

Recording in BCS Editor can be carried out both in a separate file, and also directly to the 
selected audio track. In the latter case different variants of record are available: 

• Record with insert (new recorded audio material shifts the sound existing on the 
track 
to the right); 

• Record with substitution (new recorded audio material replaces material existing 
on the track); 

• Record with mixing (new recorded audio material is mixed with material already 
recorded on the track); 

• Record with fade-in («from a hook»; it is most used at present). 

2.3.4  Editing 

In BCS Editor two types of editing are implemented: two-channel and multichannel. 

• Two-channel editing takes place when only one or two tracks exist in the project. 
The typical example of such project is a text reporting on music or noise 
background. 
It is most frequently used type of editing. 

• Multichannel editing takes place when more than two tracks are present in the 
project. In the multichannel editing mode creation of commercial trailers, thematic 
and literary - drama programs, speech programs with complex musical and noise 
background, etc 
is possible. 

The division into two-channel and multichannel editing is relative and is made only for 
user’s convenience. 

For each of editing types there are two accessible technologies: 

• Editing by markers; 

• Editing by segments. 
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The difference of two technologies is in what is assumed as the basis for audio editing, 
the segment or track with markers. 

Questions of applicability of both technologies in different situations are beyond this 
manual; the detailed description of work in each of two cases is resulted in section 3. 

2.3.5 Editing operations 

Editing operation is any operation which is carried out during editing (deleting, copying, 
cutting, moving, mixing, etc.). 

First of all note, that editing in BCS Editor is not destroying. All sequence of operations 
is kept from the very beginning, which allows providing absolute step-by-step return down 
to an initial state of the project. 

The majority of editing operations are carried out through the clipboard. Any fragment 
can be copied or cut out from the track to the clipboard and then is repeatedly used for 
inserting, forming a new segment. At the points of deleting or inserting of audio fragments 
crossfades are automatically formed - imposing of one segment on another with adjustable 
fade, providing smooth transition from one segment to another (to analogy with angle 
gluing of recorder tape). 

2.3.6 Fragments, markers and labels 

All editing operations are carried out over the selected fragment, i.e. over the fragment of 
audio track located between green and red markers. Delete, move and copy to the clipboard 
operations can be applied to the selected fragment, adjustment of level of the selected 
fragment, crossfade of all segments inside the selected fragment, etc.  

Markers are vertical lines in a working window (fig. 2.3). Four kinds of markers are 
used 
in BCS Editor: 

• Green marker.  This is a marker of the beginning of the selected fragment. 

• Red marker. This is a marker of the end of the selected fragment. 

Green and red markers delimit selected fragment. Positioning of these markers is the 
basic editing operation. These two markers are also used for cutting of a segment 
simultaneously 
in the two points. Except for copying, inserting, etc., the selected fragment is used for level 
adjustment of the certain part of audio track, crossfade of all segments placed inside it, etc. 

• Blue marker. This is a marker specifying insert position. All inserting operations 
(inserting of a file in the project, inserting of clipboard contents, inserting of new 
recorded audio material) are made from a position specified by blue marker. Blue 
marker can be used for cutting segments as red and green markers. 

• Yellow marker. This is a marker specifying the current playback position. It serves 
usually for auxiliary purposes. 

The situation when several markers are in one point of audio track is displayed in BCS 
Editor by a vertical line with alternation of colors of the markers which were placed in the 
same point. For example, there are blue and yellow markers in one point on fig. 2.3. 

Each of markers can be active or not active. Thus can be only one active marker in 
each moment of time. The active marker can be moved by means of the keyboard and can 
be used for performing of some operations in relation to the position of the given marker 
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(the last 
is right for all markers, except for yellow). 

 

 

Fig. 2.3. Markers and labels 

Labels are marks of three different colors (red, dark blue and green) which serve for 
storing the certain positions in the project and fast transition to these positions (fig. 2.3). 
Labels can be set "on the fly" and can be used for preliminary marking of material during 
recording from microphone or rerecording from reporting tape recorder. In the subsequent 
process labels can be used both only for information purposes, and, for example, for creation 
of segments (with the help of the Split by labels command of the context menu of the Project 
window 
in editing mode by segments). The Customize keyboard option of the Service main menu 
allows setting convenient «hot keys» for operations of labels of different colors allocation. 

2.3.7 Playback and settings of visible part of the Project window 

While selection of markers positions of the beginning and the end of the selected fragment 
different playback methods and methods of scale changing of waveform viewing are used. 
Frequently it is possible to determine visually necessary point precisely enough. 

For exact selection of positions of green and red markers the large scale of waveform 
displaying is necessary, and for preliminary viewing and approximate setting – the fine scale. 
In BCS Editor there are special methods of fast markers setting and changes of scale 
of waveform displaying, more detailed about which will be described below in section 3. 

Playback can be carried out from any point, from position of an active marker, up to 
active marker, between green and red markers and around of a fragment limited by green 
and red markers. Last two methods are used for rehearsal of deleting operation - the most 
widespread operation at speech audio tracks editing. 

2.3.8 Processing 

BCS Editor allows processing both audio tracks of the project, and its separate parts. 
It is possible to set levels with the help of level regulator or special «level-form», - the 
«rubber string»; similarly it is possible to normalize the audio track level. Frequency, 
dynamic and other special processing is accessible to application through the system of 
external filters Plug 
In connection.  

2.4 Working windows of BCS Editor 
After opening of BCS Editor its working window is empty by default. After opening or creation 
of the new project with the help of the View menu the user has an opportunity to set the 
working window at his own discretion depending on his task. In general it is possible to 
display the following windows: 
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Editing windows: 

• The BCS Editor window or Project window; 

• The Text editor window or Subject window; 

Data Windows: 

• Fragments window; 

• MDB (DB) window; 

• Files window; 

• Schedule window. 
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• The area of indication of project duration (fig. 2.6). Switching on / off of function 
buttons located in this area, allows to change operating modes of tracks; 

 

Fig. 2.6. The area of indication of project duration 

• The area of indication of markers position (fig. 2.7). In the area of indication 
of markers position and positions of the visible part of waveform the positions 
of markers are viewed and set, and also the position and size of the visible part 
concerning entire project is adjusted; 

 

 

Fig. 2.7. The indication area of markers positions 

• The area of adjustment of level of a signal; more detailed about handling 
of adjustment area is described in section 3.3.8. 

• The string of mode setting. This area allows adjusting parameters of audio input 
and audio output in BCS Editor. All changes in this area should be made only by the 
qualified experts; 

• The status line. In the bottom part of the screen, on the status line, the information 
on status of BCS Editor is displayed. 
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Fig. 2.8. The waveform area 

As it was mentioned earlier, editing in the Project window can be made in two modes 
(editing with the help of markers or segments), selecting one of them is made by the special 

button: . The waveform area displays the various information depending on the selected 
operating mode: 

• Track with indication of segments switched on. The mode of indication of 
segments allows displaying segments with the help of trapezoid frames. Moreover, 
segments are marked with color (white and black by turn). In this mode it is 
convenient to move segments, to set fades, to change length of the segment, to 
correct the beginning and the end of the segment. If there are fades with 
segments or imposing of one segment to another in the top strip above the 
waveform, points of segments mixing are displayed by pieces of red and yellow 
color. The red piece specifies that in this place there is an imposing of one 
segment to another (at playback of such part there 
is equal mixing of segments). The yellow piece specifies the length of segment 
fade. Operations segment editing (moving, deleting, fade setting, correction of the 
beginning and the end of segment) can be carried out only with the selected 
segment. When the segment is selected, its frame is painted in crimson color. 
Besides nodes 
of the frame are marked with small squares, moving which it is possible to change 
fades or length of entire segment. 

• Track with the switched off indication of segments. In the mode with the switched 
off indication of segments work with markers is only possible (all segments are 
displayed as continuous waveform). Following editing operations are active: copy, 
insert and delete of the fragment between markers, cut out of the fragment. 

Necessary to note, that indication of crossfades and fades parts is present irrespective 
of switching of the mode of segments indication on or off. It allows controlling the structure 
of audio track and not to overload waveform with segments displaying. 

In the top part of track waveform there is a strip which serves for displaying of 
crossfades and fades pieces, and also labels, i.e. places of audio track marked by the 
operator during recording or playback. The labels look like triangular signs of red, yellow or 
green color. 

Above the mentioned strip there is an area of activation and indication of markers 
position. One of three working markers (green, red or blue) is always in active status. 
Modes of listening «from a marker» and «up to a marker» are functioning using an active 
marker. For activation 
of a marker it is necessary to «click» the mouse on a window of the selected marker. In tab. 
2.1 color indication of markers windows in the field of activation is described. 
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The blue rectangular and grey figures display position of a blue marker in active status. 
And, on the contrary, the grey rectangular and blue figures display position of a blue 
marker in inactive status. 

The blue marker specifies a position of an insert. All operations of an insert (an insert 
of a file in the project, an insert of contents of the clipboard) are made from a position 
specified by the blue marker. By default Split operation is also made in a position 
of a blue marker. 
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The green rectangular and grey figures display position of a green marker in active 
status. The grey rectangular and green figures, on the contrary, display position 
of a green marker in inactive status. 

The green marker is the marker of the beginning of the marked fragment. Operations 
of deleting and removal in the clipboard are applied to the marked fragment. The marker 
itself can serve for executing of the certain type of operations: cuttings of segments 
in marker position, playback of a fragment between markers, etc. 
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The red rectangular and grey figures show position of the red marker in active 
status. 

The grey rectangular and red figures display position of the red marker in inactive 
status. The red marker is the marker of the end of the marked fragment. 
Operations of deleting and removal in the clipboard are applied to the marked 
fragment. The marker itself can serve for execution of the certain type of 
operations: cuttings of segments in marker position, playback a fragment between
markers, etc.  

 
The grey rectangular with black figures and a symbolical designation of red and 
green markers on each side is a length of the fragment between green and red 
markers. 

 

 

The grey rectangular and yellow figures display position of the yellow marker 
in inactive status. 

The yellow marker is the marker of current playback position; it is used basically 
with the information purposes. 

Fig. 2.1. Color indication in the field of activation and indications of markers position 

In the bottom part of the waveform window we can see the time scale on which 
it is possible to determine the entire duration of the project, position of segments on a time 
scale or their length. Above the scale, the zone of markers fast setting is located. Left mouse 
click over this zone places the blue marker to the corresponding position. If you move the 
mouse to the left or to the right, not releasing the button, the marker moves together with 
the cursor. Right button mouse click causes setting of red and green markers in the cursor 
position. If you move the mouse to the left, the red marker (the end of a fragment) remains 
on its place, and green marker moves together with the mouse. Movement to the right, on 
the contrary, keeps the green marker (the beginning of a fragment) on its place and moves 
the red marker. At any changes of positions of red and green markers, the red marker is 
obligatory placed to the right of the green one. 

To the left of the waveform window, the level-form and the control board of the project 
duration is located, having the following control elements: 

•  / - adding / deleting of additional tracks in the project window; 

•  - switching on / off of the Solo mode. At listening only that track which has Solo 
mode switched on, is played back. If there is no such track, all tracks which have 
Mute mode switched off are mixed; 

•  - switching on / off of the Mute mode – switching off of tracks in playback 
mode. All tracks which have Mute mode switched on, do not participate at playback 
mixing. 
If the track has Solo mode switched on, only this track is played back at listening 
despite of Mute state. 
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2.4.2 The Text editor window 

 

Fig. 2.9. The Subject window 

The Text Editor is the environment for working out of text–and–audio sequence. With the 
help of this window it is possible to type the text and to insert audio files or projects files 
into 
it, creating thus the finished subject for broadcast stations, for example for news summary. 

Switching on / off of the Text Editor window is made by the button . 

Variants of the Text Editor window appearance (fig. 2.9) in BCS Editor are shown 
below and its basic elements are described. 

More detailed description about working in BCS Editor will be given in the following 
sections. 
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Next Button Begin button Stop button Setup Button 

Text 

Next audio insertion 

Audio insertion 

Fig. 2.10. The Subject window, detailed description 

2.4.3 Auxiliary windows 

Files, MDB and Schedule modules serve as auxiliary windows of BCS Editor, looking 
identically 
to the same modules of program DJin of DIGISPOT® II system. Displaying of these windows 
is switched on with the help of the View from main menu. The detailed description of the 
availabilities of these windows is given in DJin manual. 

2.5 The fragments window 
The Fragments window is intended for intermediate storage of sounds and texts used in 
the current projects or subjects. It is the original buffer in which it is possible to store the 
necessary set of a material and operatively use it, inserting or deleting items from the 
Project window 
or the Subject window. 

Purpose of the Fragments window consists in increase of convenience of the operator 
working with BCS Editor. The Fragments window is a place where it is possible to keep 
initial materials and intermediate working results to have them always within reach. 

The basic concept for work with the Fragment window is the fragment. The fragment 
is sound, text or their combination stored in the Fragments window. 
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Fig. 2.11. The Fragments window 

Use of the Fragments window during work process is not obligatory. On the one 
hand, you can collect the necessary material in the buffer preliminary and partly use it at 
your own discretion. On the other hand, it is possible to record audio, type the text and 
create the subject, not using the Fragments window at all. 

There can be following types of material in the Fragments window. 

• Audio. The audio fragment located in the buffer receives a mark . For the user 
it is completely indifferent, what is this audio: the audio file or the project; he can 
put this fragment either in the Project window as the entire segment (audio) on 
one track, or in the Subject window, as the audio insert. 

• Text. The text fragment located in the buffer receives a mark . It can be the text 
file loaded from MDB, or simply record (individual text) from the Subject 
window. The text file loaded from the Fragments window in the Subject 
window, is represented 
as one record. 

• Set of texts. The set of text records located in the Fragments window receives 
a mark . For creation of a set it is necessary to collect a group of necessary 
records with the help of the Shift key and the mouse and to enter them in the 
Fragments window. 

• Text – audio or the text-audio sequence receives a mark  in the Fragments 
window.  

More detailed the work with fragments in the Fragments window is described 
in section 3. 
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3 HOW TO START WORKING with BCS EDITOR  
 

The basis cycle of work with BCS Editor looks as follows: 

• Creation of the new project or opening already existing. For the created project 
it is possible to accept an existing name or to give new. If you worked over the 
project earlier and have postponed this work, your unfinished work can be loaded 
from 
a folder or MDB. 

• Adding of initial material. Record of sound, loading of audio files from the Files 
module or from MDB, entering of the text or loading of text files from the Files 
module 
or from MDB is made on this stage. 

• Work with the project. Work with the project means audio and text editing. The 
essence of work consists in creation of the audio, text or text–and–audio material 
prepared for broadcasting. The sound can be edited (cut out, copied, transported, 
processed and mixed), and the text can be created and compiled. Of course, during 
audio-and-text editing you can import a new material to the project. 

• Storing / mixing of the ready project. The ready project can be placed in some 
folder or directory of the file structure or in MDB (whence later it can be inserted 
into the schedule of the DJin broadcasting station. Besides the project can be mixed 
in one audio file, in this case all text information contained in it, is lost. 

 

Fig. 3.1. Several projects opened in BSC Editor 

3.1 Creation of new or opening of earlier created project 
To begin working with BCS Editor you need to perform any of actions listed below: 

• create a new project; 



 
e.mail: info@tract.ru  e.mail : sales@digispot.eu  
 web :http//www.tract.ru  web :     www.digispot.eu   
 
 
 

7393 DIGISPOT BCS Editor English Version.doc  Page 25 of 102  

 

 

Cooperation for Development of Hard-and Software for 
Audio and Video Broadcast Studios in East and West 
Europe. Design and Manufacturing of Studio Equipment  
for the Audio recording Industry and the in field of Video 
Postproduction. 

• load (or open) earlier created project or subject from file structure or the Files 
module; 

• load (or open) audio or text file from file structure or the Files module and, thus, 
create the a project; 

• load a project or subject which is an element of DIGISPOT® II MDB; 

• load audio or text file which is an element of DIGISPOT® II MDB, thus having the 
new project created. 

Note that several projects can be opened simultaneously. 

BCS Editor does not assume separate commands and operations for subject creation. 
As it was mentioned above, the division of a working material into the project and subject 
in respect to the program is rather relative. With the purpose of providing of comfortable 
user’s work this division is made only at a stage of storage of the material. 

So let us stop in more detail on each of the above listed items. 

3.1.1 The new project 

After starting of BCS Editor you will have the following picture on the monitor: 

 

 

Fig. 3.2. Main window of BCS Editor 

To start working you need to create a new project or open earlier created project. 
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Fig. 3.3-a. The Project Properties window, the Common tab 

Creation of a new project is carried out with the help of the New Project command of 
the File menu. After executing of this command, an audio track is opened in the working 
window, and the name of the new project (NoName) is shown in the header. If you plan to 
give 
a special name to the project, you can do it with the help of the Project Properties window, 
which can be called via Project properties item of the Project menu (Fig. 3.3). The name 
of the future project is set in the Name field on the Common tab. On the same tab it is 
possible to specify additional parameters, such as Artist and Author. 

You can keep your comments on the project in the Comments tab (Fig. 3.3-b). 

 

 

Fig. 3.3-b. The Project Properties window, the Comments tab  

Parameters are described in more details in section 4. 

During creation of a new project, the BCS Editor automatically creates only one audio 

track. Adding of unlimited number of tracks can be done by the  button located in the 
bottom part of the display to the left of the tracks area, or with the help of the Create track 
command of the Project in the main menu. Removal of unneeded tracks could be performed 

either with the help of the  button located close to  in the bottom part of the display, or 
with the help of Delete selected tracks item, accessible in the Project menu and in the 
context menu 
of tracks audition control zone (between waveform and level-form). 

To start working with the created project, you need to fill it with audio and text content. 
Within the BCS Editor it is possible: 

• To record audio track from a microphone or any external audio source connected 
to audio card input; 

• To import audio file to the project, i.e. "to put" it on a track, having selected it in 
the file browser, Files module or MDB; 

• To enter text using keyboard; 

• To import ready text file. 

More details about filling a project with the content will be given later. 

3.1.2 Opening the existing project 
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Click File - Open to open earlier created project. This command opens standard Windows 
file browser where you have to select the needed project or subject. 

It is also possible to open the existing project with the help of MDB (if the purchased 
license allows it). Click Database in the View menu to open the MDB window of the 
DIGISPOT® II system. Using drag&drop method drag an existing project (the fact that the 
item selected 
in MDB window is really a project could be checked up in the Object properties window, in 
the Type field) to a main window of the BCS Editor. 

Similar procedure allows opening of the project with the help of the Files module. 
Select Files from the View menu to open the window of the same module of DIGISPOT® II 
system. Drag earlier created project in the main window of BCS Editor (fig. 3.4). 

 

Fig. 3.4. Import of material from MDB 

By the way, with the help of the given command it is possible to open not only the 
project or subject, but also an audio or text file. In case of audio file loading, it is placed on 
a track 
of audio editor; the new project with a name of the selected file is created simultaneously. 
The text file is placed in the new project in a text editor window. 

3.2 Import of source material 

3.2.1 Audio recording 

Recording is always made on the selected (active) track; if there are several selected tracks, 
the recorded material appears on the upper track. 

Enable record mode by pressing the  button. You will see record panel under the 
main toolbar. Simultaneously the project audio level indicator is switched to display the level 
of the input signal. 
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Fig. 3.5. The record panel 

Record panel shows the current format of recording, length of the recorded fragment 
and available disk space in HH.MM.SS format. Last two figures are dynamically updated 
during the record. Control of the process is carried out with the help of the following 
elements: 

•  /  - record disable/enable; 

•  -  pause; 

•  - insert mode. In this mode the record takes place from the inserting marker 
position. Segment is being split in that position and a new segment is being 
inserted here. The length of this segment increases in the process of record. All 
segments following recorded one, are shifted to the right. After finishing of record 
in the end 
of the recorded segment the crossfade with the following segment is created; 

•  - overwrite (substitution) mode. In this mode the record takes place from the 
inserting marker position and the segment is split in that point (if there is a 
segment there). The length of a new segment increases in the process of record. 
The new content is overwriting old content. In the end of the record, a crossfade of 
the recorded segment with previous segment is inserted. All segments which are 
located "under" the recorded one, are removed; 

•  - mix mode. In this mode the record looks as follows: the new segment to 
which the record is made, is added from the insert marker position. The length of 
this segment increases in the process of record. All other parts of the track remain 
without change; 

•  - pre-roll record. On switching of record, the playback begins from a position, 
preceding the insert marker by the pre-roll value (which is set in record 
parameters), and when it reaches the blue marker position the record begins. If 
pre-roll is switched off, the record begins right from the current position. 

•  - setting the record format. Press this button to open the dialogue in which 
parameters of the record format are set: Sampling frequency (number of samples 
per second; bigger sampling frequency provides better record quality, but requires 
more disk space), Stream (this parameter is used only if MPEG compression 
is selected, and it specifies the audio compression degree; similar as sampling 
frequency, the greater stream provides better record quality, but requires more 
disk space), Channels (specifies type of record: mono or stereo; in case of record 
with MPEG format compression it is possible to set stereo record type: Joint Stereo 
or Dual Channel. Use of one of these types allows to reduce some final volume of 
record, practically not changing its quality) and the Compression (sets audio 
compression type: the linear sound is uncompressed sound; it occupies a lot of disk 
space, but provides better audio quality; mpeg - is the sound compressed in MPEG 
format; 
it allows to reduce disk space considerably (sometimes, to a degree); the 
compression degree is determined by the Stream parameter. 

3.2.1.1 The second way of recording on a track 
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Fig. 3.6. Record Tool window 

It is also possible to record an audio segment on a track as follows. By positioning the 
blue marker on that place, whence the record need be done, open the context menu of the 
waveform window. Select the Record file item in this menu to open the RecTool window 
providing record with a method of imposing from the blue marker position. 

With the advent of the window, the  button is switched to “on” position, i.e. the 
record mode is armed. When the signal is fed to the input it is possible to adjust its level by 
moving two dark blue markers imposed to the indicator. To set level in one of the channels 
place the cursor to the indicator of the corresponding channel, press and hold the left button 
and move the mouse up or down. For simultaneous change of a level in both channels bring 
the mouse cursor not to the indicator of one of channels, but to the interval between them. 
More details about working with the level indicator are given in section 3.3.8. 

To activate recording after setting levels click the  button. In the Recorded field 
the time past from the moment of the record start is displayed. During record you can make 

a pause by pressing the  button. Record is deactivated by clicking of  button. 

After finishing of record you can listen to the recorded material; for this purpose 

disable the  and click . While listening, the toddler Playback moves, specifying the 
current position. 

After the listening finishes press ОК. Contents of the temporary file in which record was 
carried out, will be placed on a track, forming a new segment. All next segments are shifted 
to the right. By pressing Cancel record is cancelled. 

3.2.2 Audio import 

If you want to «put» any audio file on a track, call the context menu by right-clicking mouse 
and select Place file. Standard Windows file browser will be opened where it is possible to 
find needed audio track. Having selected the needed file click Open. The Place file 
command acts only on the track from which the context menu was called, independent from 
a status of other tracks selection. 

It is possible to load audio files into the project not only from file structure, but also 
from the Files module or from MDB. Select the Data base item of the View menu to open 
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the MDB window of DIGISPOT® II system. Using the drag&drop method drag any needed 
audio file to a main window of BCS Editor (the fact that the item selected in MDB window is 
really an audio file could be checked up in the Object properties window, in the Type field). 

Similar procedure allows opening a project with the help of the Files module. Select 
Files item of the View menu to open the Files window of the DIGISPOT® II system. Using 
the drag&drop method drag any needed audio file to the main window of the BCS Editor. 

Procedure of import can occupy some time. When the imported file is loaded in a main 
window, it is possible to begin its editing within the frames of the new project. 

By the way, if the basic purpose of current project is just editing of a single audio file, 
it is possible simply to open this file instead of the long chain of actions including creation 
of a new project and import of the interesting audio file on a track. The project in this case 
will be created automatically. 

3.2.3 3.2.3. Working with the text. Import of text files and creation of text – and – audio 
sequences 

For typing text open the Subject window with the help of the  button located in the 
bottom of the screen to the left of tracks. 

By default the area for text editing is already open in the Subject window. In the same 
window it is possible to insert audio tracks into a body of the text. Working in this mode 
allows creating a news release, where text to be read by moderator in microphone alternate 
with already recorded audio reports, compiling and compositing a program for their 
subsequent airing. 

Import of a text into the window can be made both with the help of clipboard from any 
other text program, or with the help of the Open command of the File menu. 

Similarly to projects and audio files, the text can be imported with the help of MDB or 
the Files module. 

Adding of audio tracks is made with the help of the Create new audio item of the context 
menu in text editing window. To edit audio material residing in the text editing window you 
should use audio editor. Working with the text is described in more details below in section 
3.3.9. 

3.3 Working over the project 

3.3.1 Time scaling and positioning 

Time scaling in BCS Editor is used for optimal displaying of visible part of waveform according 
to a current task. For example, if you are compiling report and moving big pieces of audio, 
you need to see the most part of waveform; and, on the contrary, if you are cutting small 
clicks from the recording you need to see waveform in very detailed scale. Generally, optimal 
time scale which allows seeing reasonable part of waveform, distinguishing visually its 
fragments (words, pauses, musical accents), providing comfortable speed of playback marker 
makes approximately 20 seconds of audio on the screen. 

Positioning of markers on the key points of waveform, convenience and sufficiency of 
these operations, is a key to effective and optimal editing. Different methods of markers 
manipulation are described below. 

There are several methods of time scaling and markers repositioning in BCS Editor. 
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3.3.1.1 Time scaling and positioning by means of "magnifier" - dark-blue strip. 

The dark blue strip with markers icons can be used for changing time scale of waveform, for 
positioning of visible part of waveform and for repositioning of the markers. 

 
Entire waveform 

Visible part of audio track 

 

Fig. 3.7. Time scaling and positioning by means of dark-blue strip 

Positioning. Put the mouse cursor over the dark-blue strip, press and hold the left 
mouse button and move it (the cursor will change its shape for a magnifier) to change the 
position 
of the visible waveform part relatively the entire project. Waveform window will 
correspondingly follow the selected part of the tracks of the project. 

Scaling. Put the mouse cursor to the left or to the right border of the dark-blue strip, 
press and hold the left mouse button and move it (the cursor will turn to ) to change the 
position 
of the left or, accordingly, of the right border (and also the length) of visible waveform 
window. The length of the dark-blue strips relatively the length of entire window in a 
framework displays the relation of length of visible part of the project to duration of the 
whole project. 

Except for change of scale and position of visible part of the project it is possible to 
change position of the markers. For this purpose put the mouse cursor to the corresponding 
marker, press the left button of the mouse (the cursor will turn to ) and move the cursor; 
the selected marker will follow. If a marker gets in the visible waveform window it will also 
synchronously move there. 

 
3.3.1.2 Scaling by means of selection 

If you want to view a concrete part of waveform put the mouse cursor to the selected point 
on a track, press the right button and holding it, select the necessary part by moving mouse 
to the left or right (the cursor will take the form of a magnifier). After releasing of the right 
button the selected part is stretched to the whole window. To cancel this mode press left 
mouse button while holding the right one - the scale of display remain unchanged, and the 
mode 
of scaling will be cancelled. 
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Fig. 3.8. Time scaling by means of selection 

3.3.1.3 Scaling by means of hot keys 

You can change scale of the visible waveform part by means of keys + and – of a standard 
keyboard. The visible part similar to the dark blue strip (and the magnifier) changes relatively 
the left border. 

Pressing the + key, you increase the scale (increase the resolution), thus, the waveform 
is more detailed, the displayed duration decreases, the length of magnifier also decreases. 

Pressing the - key, you reduce the scale (reduce the resolution), as a result the 
waveform is less detailed, the displayed duration increases, the length of magnifier also 
increases. 

3.3.1.4 Positioning by means of virtual buttons and hot keys 

BCS Editor has also a set of virtual buttons for fast positioning to the most frequently used 
parts of the audio track (the keys specified here correspond to default settings, depending on 
system parameters they can differ; please refer to section 4 for the list of hot keys and 
instructions how to program them via Customize keyboard item of the Service menu). 

 

 
Move the magnifier to the beginning of the track. Thus the waveform scale 
does not change, and the visible part moves to the beginning of the waveform 
window. At standard settings of hot keys, this operation can be done, using 
the Home key of the keyboard. 

 
Move to the left. Thus the scale does not change, and the waveform moves to 
the left on ¼ of its length. At standard settings of hot keys, this operation can 
be done, using the PgUp key of the keyboard. 

 
Move to the right. Thus the scale does not change, and the waveform moves 
to the right 
on ¼ of its length. At standard settings of hot keys, this operation can be 
done, using the PgDown key of the keyboard. 

 
Move the magnifier to the end of the track. Thus the waveform scale does not 
change, and the visible part moves to the end of the waveform window. At 
standard settings of hot keys, this operation can be done, using the End key 
on the keyboard. 
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3.3.1.5 Positioning by means of the dragging of the waveform itself  

The method of direct moving of the visible waveform part in the track is very convenient. 
For this purpose put the cursor in any part of the track and press the left button of the 
mouse. The cursor takes the following form: . Now, if you start moving the mouse 
horizontally not releasing the left button, the waveform will “follow” the cursor. Thus it is 
possible, for example, during playback to follow the playback marker manually. Sometimes 
it is extremely conveniently in contrast to automatic updating of the waveform position in 
the main window. 

3.3.1.6 Moving markers 

Let's consider a variant when we do not need to move waveform; we need just to position 
markers. 

One of the most useful skills is a positioning with mouse when the cursor is in the zone 
of fast markers installation. 

 

 

Fig. 3.9. Moving markers 

When the cursor is in this zone, it looks like I. Now position the cursor to a specific 
point 
of the waveform – where you want to put marker. Press the left mouse button to bring the 
blue marker in this position. While holding left button pressed, you can drag the blue 
marker to the left or to the right (the cursor takes the shape of the hand). Press the right 
mouse button 
to bring red and green markers in this position. While holding right button pressed, you can 
drag to the left the green while the red marker (the end marker of the fragment) remains 
on its place. Dragging to the right, on the contrary, keeps the green marker (the beginning 
of the fragment) on its place and moves the red marker. At any changes of positions of red 
and green markers, the red marker is obligatory to the right of the green marker. 

Tab. 3.1 resulted below shows all functions of moving and positioning which are 
realized 
in BCS Editor. These actions can be carried out with the help of hot keys, mouse or the 
context menu. 

 

Function Key 



 
e.mail: info@tract.ru  e.mail : sales@digispot.eu  
 web :http//www.tract.ru  web :     www.digispot.eu   

  
  
 

 

 

 

Cooperation for Development of Hard-and Software for 
Audio and Video Broadcast Studios in East and West 
Europe. Design and Manufacturing of Studio Equipment  
for the Audio recording Industry and the in field of Video 
Postproduction. 

Put green marker (fragment beginning) to the playback marker < 

Put red marker (fragment end) to the playback marker > 

Put blue marker (insert ) to the playback marker ? 

Put green marker (fragment beginning) to the insert marker ( 

Put red marker (fragment end) to the insertion marker ) 

Put playback marker to the green marker  { 

Put playback marker to the red marker } 

Activate the blue marker (insert)  F2 

Activate the green marker (fragment beginning)  F3 

Activate the red marker (fragment end)  F4 

Set the green and red markers on the screen boundaries F7 

Put the blue marker (insert) to a middle of a screen F8 

Move an active marker to the left / to the right Left/Right 

Move an active marker one screen to the left Ctrl+PgUp 

Move an active marker one screen to the right Ctrl+PgDn 

Move an active marker to the beginning of the project Ctrl+Home 

Move an active marker to the end of the project Ctrl+End 

Put blue marker (insert ) to the green marker (fragment beginning) 9 

Put blue marker (insert ) to the red marker (fragment end) 0 

Tab. 3.1. Moving markers hot keys  

3.3.1.7 Mutual moving of markers and waveform 

Sometimes it is useful not only to move markers, but also to move and scale the waveform 
simultaneously, available variants are resulted in tab. 3.2. 

 

Function Key 

Set the screen to markers of the beginning and the end Ctrl+F7 

Set the screen to the insertn marker  Ctrl+F8 

Tab. 3.2. Hot keys of mutual moving of markers and waveform 

3.3.2 Audio editing  

The basic work in BCS Editor is editing. Audio editing can be performed in two modes: 
in markers mode or in segments mode. In the first case segments also exist, but are not 
displayed. 

All actions made by the user are memorized; the number of memorized actions of the 
user is not limited. Cancellation of last editing operation is made by the Undo command of 
the Edit menu (the cancellation of operations is made in the reserve order). Cancellation of 
the Undo command can be done with the help of Redo. Redo operations are done in the 
same order 
in which they were originally applied. 



 
e.mail: info@tract.ru  e.mail : sales@digispot.eu  
 web :http//www.tract.ru  web :     www.digispot.eu   
 
 
 

7393 DIGISPOT BCS Editor English Version.doc  Page 35 of 102  

 

 

Cooperation for Development of Hard-and Software for 
Audio and Video Broadcast Studios in East and West 
Europe. Design and Manufacturing of Studio Equipment  
for the Audio recording Industry and the in field of Video 
Postproduction. 

3.3.3 Editing: markers mode 

The markers mode of editing assumes that indication of segments is switched off. In this 
case the editing can be fulfilled only by main editing operations: deleting and inserting of 
fragments. Most of operations which can be done in this mode affect also segments, in this 
connection 
it is impossible to draw a rigid distinction between two modes of editing. 

Editing operations in markers mode include the following commands of the Edit menu 
(and, accordingly, the context menu of the Project window in markers mode): 

• Copy - copying of the track fragment between green and red markers to the 
clipboard. 

• Cut - cutting of the track fragment between green and red markers to the 
clipboard. This command influences segments even if their displaying is switched 
off: segments with red and green markers are spliced in the positions of markers, 
segments located behind red marker are moved left to the length of cut fragment, 
and the crossfade 
of segments takes place in the green marker position. 

• Delete - deleting of the selected fragment of track without copying to the 
clipboard. Segments with red and green markers are spliced in position of 
markers; segments located behind red marker are moved left to the length of cut 
fragment, and the crossfade of segments takes place in the green marker position. 

• Clear - erasing audio from the selected part of the track. This operation differs 
from the Delete command by the fact that the length of source audio material 
does not change, since cleared fragment of track is filled by silence. 

• Paste - inserting of the clipboard contents into the track at the blue marker 
position. Thus the track is spliced in the position of blue marker, the material 
located to the right of the marker is shifted right wise to the length of inserted 
fragment, and the fragment is inserted into this place from the clipboard (prior to 
execution of this command the clipboard should contain a valid material as result 
of Cut or Copy commands). This command is also used for working with 
segments. It is important 
to understand, that after executing of this command one segment inside of which 
the insert has been made, is replaced by three new segments with crossfades in 
between them – all that independently of the mode you are working in (markers 
or segments). If the segments have fades, or if one segment is imposed on 
another, mixed parts are displayed by pieces of red and yellow color in the top 
strip above the waveform. The red piece specifies that there is an imposing of one 
segment to another at this place (at playback the segments are mixed in equal 
proportion). The yellow piece specifies the length of a segment fade. Last releases 
of BCS Editor have two versions of the Paste command. First, - Paste [], results 
in replacing of the fragment bordered with green and red markers by contents of 
the clipboard; this command is present only 
in the context menu of the Project window in a markers mode of editing. Second 
version, To last track [] command "sends" the selected fragment to the last 
track 
of the project; this command is present only in the context menu of the Project 
window in markers and segments modes of editing (in the latter case - only by 
calling of the menu not from the area of an active segment). 
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• Mix – imposing of the contents of the clipboard to the track starting from the blue 
marker position (as a result a new segment appears, as in case of Paste). Thus the 
new fragment is mixed with already existing audio. After execution of this command 
the imposed fragment is displayed in the waveform window with black color, and 
mixing zone is displayed with grey color, it is also displayed by a red strip in a zone 
of «crossfades and fades». 

So we have described editing possibilities given by BCS Editor in markers mode. 
Methods 
of real work can be extremely various, they depend on character of carried out works, 
individual habits, presence of remote control devices, etc. 

 

3.3.4 Editing: segments mode 
3.3.4.1 Structure of a segment 

The segment represents the integral finalized audio fragment at which the beginning and the 
end can be “hidden”. The important feature of a segment is that it always keeps its initial 
contents in it. 

When you insert an audio file or contents of the clipboard on a track or if you record a 
new audio material, audio is imposed on a track as a segment (even if indication of segments 
is switched off). Further, whatever you do with a segment (cut, create a fade, adjust level, 
change length, adjust beginning and end), it will always keep all its initial contents in it. All 
operations made with a segment, are not destroying, i.e. at any moment there is an 
opportunity to “take" all its contents from a segment. 

 

 

Fig. 3.10. Structure of a segment 

The structure of a segment is displayed on Fig. 3.10. The segment is represented 
intentionally in a form of roll with wrapped edges; this analogy represents essence of a 
segment very good. In the beginning when you have just created a segment, it represents a 
roll with straight edges (not wrapped). Then, when you edit the segment changing its length, 
you wrap the edges of the roll with possibility to unwrap them again if it is needed. The violet 
trapezoid frame represents the "working" area of a segment. 

To drag a segment on a track of the project (on which the infinite number of segments 
can be placed) you can grasp a mouse for segment’s frame. In the corners of this frame 
there are four small squares, intended for adjustment of the length of a segment and setting 
of fades. Fades (fade-in and fade-out) serve for the indication of duration of segment mixing, 
fade-in – beginning of segment and fade-out – end of it. To adjust edges of a segment or to 
set fade duration, grasp a corresponding square with the mouse (bottom square is for 
adjustment 
of length or top square for changing fade) and drag it. 

Segments can be placed on a track in a free manner. Possible combinations of its 
relative arrangement on a track are represented on Fig. 3.11: here segments 1 and 2 form a 
crossfade. At playing back of this track on that part where fragments of both segments are 
present, they are mixed taking in account fades settings. The segment 3 is imposed on a 



 
e.mail: info@tract.ru  e.mail : sales@digispot.eu  
 web :http//www.tract.ru  web :     www.digispot.eu   
 
 
 

7393 DIGISPOT BCS Editor English Version.doc  Page 37 of 102  

 

 

Cooperation for Development of Hard-and Software for 
Audio and Video Broadcast Studios in East and West 
Europe. Design and Manufacturing of Studio Equipment  
for the Audio recording Industry and the in field of Video 
Postproduction. 

segment 2, i.e. at playing back on the segment’s part 3 it will be mixed with the segment 2. 
Segments 2 and 4 are located "line-in-line", i.e. the part of their joining will be played back 
as single fragment. 

 

 

Fig. 3.11. Example of relative positioning of segments 

3.3.4.2 Editing operations 

Editing operations in segments mode include the following commands of the Edit menu 
(and, accordingly, the context menu of the Project window), called from the selected 
segment area: 

• Copy segment – copying of the segment selected on a track to the clipboard. 

• Cut segment – cutting of the segment selected on a track to the clipboard. 
Segments located to the right, are shifted left wise by duration of a cut out 
segment. Automatic crossfade is formed between the segments located to the 
right and to the left of cut out segment. 

• Delete segment – removing of the segment selected on a track without changing 
the clipboard contents. Segments located to the right, are shifted left wise by 
duration 
of a cut out segment. Automatic crossfade is formed between the segments 
located 
to the right and to the left of cut out segment. 

• Split - this command has 2 versions: Split by marker and Split []. As it is 
obvious from the name, the first command splits a track out to two segments in a 
position 
of an active marker; the second version of this command forms a new segment 
between markers, i.e. carries out two cuttings simultaneously. More details about 
Split command will be given below. 

• Create segment [] - this command combines all segments enclosed between 
green and red markers into one. Simultaneously splitting appear at the points of 
green and red markers. 

Basic editing operations with segments are made due to the following functions: 

• Moving a segment. Moving is carried out by “grasping" a framework by a mouse. 

• "Wrapping" of the left or right edge (change of a point of the beginning and the 
end 
of an audible part of a segment) – by means of “grasping" bottom left or right 
squares with a mouse. 
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Fig. 3.12. Basic editing operations with segments 

Further most frequently used operations of editing with the help of segments will 
be discussed in more details: cutting out, moving, wrapping and unwrapping. 

3.3.4.3 Splitting of a segment 

One of common operations while working with segments is Split operation. As a result the 
segment at the blue marker position is split and thus two new segments are formed. These 
segments are joined in such a way, as if nothing has happened with a sound. Afterwards 
these segments can be moved independently, mixed with others, etc. As can be seen from 
the figure, each of the newly formed segments has a wrap edge in the place of splitting. It 
means that actually each of the new segments represents a copy of "parental" one, but with 
appropriate wrapped up edges. All this is equal to copying of "parental" segment and 
wrapping of the right edge of one of them, and the left edge of another. Independently of a 
number of split segments, each of them, as it was already specified above, always 
“remembers” all contents of the “parental” segment. 

 

Fig. 3.13. Splitting of a segment 

Most frequently used editing operations based on cutting procedure in BCS Editor are 
removal and insertion of a fragment. We will describe these operations for a case of 
segments editing. First, you have to split the fragment to a corresponding number of 
segments, and then cut out unnecessary one. If you want to cut out a fragment from the 
middle of a segment, the latter should be split in two points - in the beginning and in the end 
of fragment that has 
to be removed, i.e. you will have three segments formed. If the fragment to be removed 
is located on one of edges of a segment, then it should be split in one point, i.e. you will have 
two segments formed. You can split a segment and remove unnecessary part using two 
methods described below in detail. 

Split method: first the segment is split manually at the borders of a fragment that 
should be removed, and then the new segment is removed (fig. 3.14). Markers method: 
Green and red markers are set at the borders of a fragment that should be removed, and 
then, as well 
as in case of editing with the help of markers, the selected fragment (fig. 3.15) is cut. 

Although both these methods are very similar, they have two certain differences. In the 
markers method segment splitting and removal of unnecessary part are carried out 
automatically. Besides as it is seen on figures, split method results in replacing of unneeded 
fragment by silence while markers method results in cutting of unneeded fragment.  
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Fig. 3.14. Split method of fragment removal 

 

Fig. 3.15. Markers method of fragment removal 

There is one more distinction that consists in convenience of application of the first 
or second methods. If, for example, you want to remove a fragment from the middle 
of a segment it is convenient to apply the second method since in this case there are less 
operations to be done. If you delete a fragment from one of edges of a segment, it is 
convenient to apply the first method, since in the second method one of the markers should 
be set precisely at the edge of a segment what is not so simple to do. 

Insertion of a fragment into a segment is practically identical to inserting in a markers 
mode of editing. The only difference is in the fact that in markers mode of editing splitting 
and moving of segments operations are hidden from the user. Insertion of a fragment in 
markers editing mode shifts all contents on a track from insert position to the right. 

During Paste operation the segment is split in two new segments in position of an 
insert point. All segments to the right of insert point are shifted to the right for the length of 
inserted fragment, and the inserted fragment forms one more segment. 
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Fig. 3.16. Splitting a segment while insertion  

Thus, three new segments are formed from one. 

In earlier versions of BCS Editor we had an opportunity to insert with imposing (fig. 
3.17), however, we decided to withdraw it, because the similar result can be achieved by 
inserting 
of a segment in the end of a track and subsequent moving to the necessary position. 

 

 

Fig. 3.17. Mode of splitting a segment with insertion switched off 

3.3.4.4 Dragging of segments 

Dragging of segments can be done as follows. 

Activate segment A and set cursor to the middle of it; cursor turns to a palm icon. Now, 
holding the left button of the mouse and Shift key (palm icon will be compressed), it is 
possible to drag a segment. On fig. 3.18 the imposing of segments A and B (mixing) takes 
place while moving of segment A to the right. 

 

 

Fig. 3.18. Dragging of segments. Initial position of segments 

There is no imposing at moving of segment A to the left (fig. 3.19). 

 

 

Fig. 3.19. Dragging of segments. Moving segment A to the right, Shift key is pressed 

If you move a segment while not pressing Shift key (only left mouse button is pressed), 
all segments located to the right of an active segment, will move together with it, both to the 
right, and to the left. A kind of "steam train" is formed of segments. Fig. 3.21 shows segment 
C moved to the right. Segments D and E are moved together with it. 
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Fig. 3.20. Dragging of segments. Moving of segment A to the left, Shift key is pressed 

 

Fig. 3.21. Dragging of segments. Moving of segment C to the right without Shift key 

If you move a segment while pressing Alt key, it separates two adjacent segments and 
inserts between them. Fig. 3.22 shows moving oа segment D to a position between 
segments 
B and C; while moving Alt key is pressed. 

 

 

Fig. 3.22. Dragging of segments. Segment D is inserted between A and B, Alt key is pressed 

Similarly the segment can be dragged on another track, thus originally it takes a 
position on a time base precisely the same as on its native track. You can move it to a 
different position as a second step. 

 

 

Fig. 3.23. Dragging of segments. Moving a segment to another track. 

3.3.4.5 Segments wrapping and unwrapping  

Using mouse you can wrap and unwrap ends of segments; to make that activate the 
segment first and put the cursor to the left or to the right bottom square. Cursor takes the 
form 
of a bidirectional arrow. Now, depressing the left mouse button, it is possible to wrap 
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or to unwrap a segment. In other words you are cutting the beginning (the end) of the 
segment, or, on the contrary, restoring it. 

Fig. 3.24 shows that the end of segment B is wrapped, therefore the certain piece of this 
segment is cut out. In the second example (Fig. 3.25) segment B is unwrapped to the left 
and imposed to the end of the segment A. 

 

 

Fig. 3.24. Wrapping the end of segment B 

 

Fig. 3.25. Unwrapping of the segment B with imposing of it on the segment A 

If you wrap or unwrap segments while holding Shift key, the imposing will not take 
place; the unwrapped segment will push all adjacent segments, and wrapped segment will 
pull them 
to it. Fig. 3.26 shows unwrapped to the left and to the right segment B which has pushed 
aside segments A and D, C, E, F, and also all subsequent content. 

 

 

Fig. 3.26. Unwrapping of segment B with Shift key pressed  

3.3.5 Editing with the help of the list of segments on a track 

Let's consider one more convenient method of working with segments. BCS Editor allows 
representing segments in the form of a list. Let us explain how to work with the list 
on a practical example. 

3.3.5.1 Practical example working with a list of segments 

So let us record interview and set labels (in the process of record) between questions and 
answers (more detailed information about labels will be given later). It is possible also to 
place labels after recording, during monitoring playback. As a result of setting labels you will 
see the following picture (fig. 3.27). 
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Fig. 3.27. Recorded interview with labels 

Now we are going to split the recorded interview to separate questions of journalist 
and answers of interviewee. Of course we will use labels that were set during recording – 
the splitting points are already in our project.  

Open the Project window context menu and select Split by labels. You can specify 
two automatic names prefixes, e.g., «Question» and «Answer»; this time we will not add 
numbers (Flag Add numbers is not set).  

 

 

Fig. 3.28. Splitting of segment by labels. 

Click Split button and you will see the following (fig. 3.29):  
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Fig. 3.29. Project window after splitting by labels 

Our interview is split to a sequence of segments representing questions and answers. 
Now, using the context menu, select the Segment window command; as a result the 
Segments 
on track 1 window (fig. 3.30) opens. 

The list of segments is actually another view of segments disposition on a track, 
represented in a tabulated form (fig. 3.31). You can playback each segment individually; you 
can assign text to any of the segments. Rows of the table can be moved using drag & drop 
method, which result in moving of audio segments on a track accordingly. Thus, it is possible 
to interchange positions of questions and answers, using this vivid form of representation. 

 

 

Fig. 3.30. The list of segments on a track 

    

Fig. 3.31. Segments on track 1 window 

The general context menu of the Segment window features the following functions: 

• Unite segments with same name - the segments having the same name are 
united in a single segment. 

• Delete hidden segments - deletes all segments hidden behind another segments. 

The local context menu of the line responsible for a certain segment, allows to: 

• Rename segment - i.e. to give another name to a segment. 

• Edit text - to type or edit the text attached to a segment (at present this function 
is under development). 
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• Unite segments with name '…' – uniting of segments with a defined name in 
one. 

If we select Unit segment with same name item, the appearance of the Project 
window takes the form as shown in fig. 3.32. 

Now, if we create the second track and drag the segment with answers on it (fig. 
3.33), 
we have the questions and answers of interview separated on two tracks what might 
be extremely convenient for editing. 

 

 

Fig. 3.32. Project window with united segments  

 

Fig. 3.33. Question and answers separated on two tracks 

3.3.6 Multichannel editing 

In general editing on several tracks is very similar to editing on one track. However the 
mode 
of multichannel editing has one essential feature which needs to be taken into account and 
to which it is necessary to get used firstly. This feature deals with cutting, copying and 
insertion of audio fragments on tracks. It was earlier noticed, that each track of the project 
can 
be selected and not selected. All operations listed above could be applied only to selected 
tracks. 

It is possible to select a track as follows: 

• To select a track click left mouse button on a grey field to the left of the waveform 
window. 
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• To select several tracks do the same operation, holding the Ctrl key pressed. 

• Simple click (without holding of the Ctrl key) makes active the selected track and 
resets activation of other tracks. 

• The selected track has turquoise color, and not selected - grey. 

Let's perform cut operation on several tracks. The initial tracks status of the project 
is displayed on fig. 3.34. 

As we can see, only tracks 2 and 4 are selected. Now let us split a fragment between 
green and red markers. Status of tracks of the project after this operation is displayed on fig. 
3.35. 

Obviously, removal of a fragment takes place only on tracks 2 and 4. Thus, if you want 
to remove a fragment from one track you should make inactive all others and only then cut 
out a fragment. It is necessary to pay special attention to it since it can happen, that there 
are some tracks in your project, but the part  of them is not visible (i.e. not all tracks are 
displayed 
in a window of the project). If one of invisible tracks is active also, the selected fragment also 
disappears on it after cut operation. 

The above described ideology concerns also operations of copying of a fragment to the 
clipboard and inserting from the clipboard on tracks. By copying a fragment to the clipboard, 
a number of tracks are created in the clipboard, corresponding to a current number of active 
tracks in the project; on each track the fragment, located between markers on corresponding 
to it track, is copied. Thus, if you are copying contents of the selected fragment to the 
clipboard in situation described above, 2 tracks will be created there. First track in the 
clipboard will get the contents of the selected fragment from a track 2, and the second track 
will get the contents of the selected fragment from a track 4. 

 

 

Fig. 3.34. Initial tracks status 
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Fig. 3.35. Final status of tracks 

Let us consider, what happens when we insert fragments from the clipboard into the 
project. Let us assume the initial situation shown on fig. 3.36. 

 

 

Fig. 3.36. Initial status of tracks 

Assuming that only two tracks are selected of the total six, we copy the selected 
fragment in the clipboard. Thus two tracks are formed in the clipboard. Then we change 
selection 
as it is represented on fig. 3.37. 

Now there are three selected tracks. Let us insert contents of the clipboard from a 
position of a blue marker, as shown in fig. 3.38. 

As we can see from the figure, the fragment from the clipboard is inserted on all 
selected tracks However, we remember, that there were only two tracks in the clipboard. 
Therefore fragments from two tracks of the clipboard were inserted on tracks 2 and 3 of the 
projects respectively. And a fragment with the same length but with no audio (“silent”) is 
inserted 
on a track 4 of the project. I.e. all audio located on a track 4 to the right of the blue marker, 
is shifted synchronously with audio on tracks 1 and 2. 
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Fig 3.37. Status of tracks after changing of selection 

 

Fig. 3.38. Status of tracks after executing of insertion 

3.3.6.1 Mixing of tracks 

The resulting product of multichannel editing can be a mix of the material to one or two 
tracks. It is possible to do it with the help of Merge tracks item of the Project main menu, 
allowing 
to unite several audio tracks or their parts in a single new segment on a new track. 

 

 

Fig. 3.39. Merge tracks window 

• Merge tracks window provides setting of the following parameters: 

• Segment name is the name of a created segment. 

• Track name is the name of a new track. 

• Merge selected –mode of uniting of selected tracks only. 
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• Merge audible –mode of uniting of not muted tracks only (on which Mute is not 
switched on). 

• Between markers - mixing only parts of audio tracks which are located between 
green and red markers. 

• Delete source tracks after merge - if this mode is switched on, all tracks which 
participated in mixing, are deleted from the project after uniting. Thus the new 
track which is located below of all others is added in the project. 

3.3.7 Working with labels 

As it was mentioned earlier, labels are marks of three various colors (red, dark blue and 
green) which serve for storing of certain positions in the project and fast browsing to these 
positions. Labels can be set "on the fly" and used for a preliminary marking of a material 
during recording from a microphone or rerecording from the reporting tape recorder. 

Working with labels is carried out with the help of the mouse and corresponding screen 
area (fig. 3.40), or "hot" keys of the keyboard. 

 

 

Fig. 3.40. Example of working with labels 

The context menu opened by a right mouse button click on a label or in the labels area 
contains the following commands: 

• Show previous label - proceed to the nearest label to the left of mouse position. 
Proceeding to this or that label brings the part of waveform with the requested 
label 
to the center of the screen. 

• Show next label - proceed to the nearest label to the right of mouse position. 

• Delete label - remove a label on which the cursor is set (this item of the menu 
appears only if context menu is opened from a label). 

Labels can be set during recording or playing back, for this purpose use preset “hot 
keys” of the keyboard (more details about options of "hot keys” are given in section 4). 

3.3.8 Waveform level control and processing 
3.3.8.1 Control and adjustment of a level with the help of the indicator 

The level indicator is a separate area of the Project window, located to the left of 
waveform area (fig. 3.41). This "device" works as usual level indicator in playback and 
record modes. You can use level indicator for level controlling in editing mode. 

Visually level setting is displayed by two dark blue stripes imposed on the indicator. 
Besides, under the indicator there is a digital value of a level setting in each channel. For 
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setting of a level in one of channels put the cursor on the indicator of corresponding channel, 
press the left button and, holding it, move the mouse upwards or downwards. The level 
setting can 
be controlled in each channel separately or in both channels simultaneously. To change level 
setting simultaneously in both channels put the cursor to an interval between two channels 
on indicator. 

Note, that use of the left button of mouse allows changing level setting from the value 
currently set in the project. If you press the right mouse button, the level first will be set to 
the value specified by cursor. 

 

Fig. 3.41. The level indicator 

Type of level controlling is selected with the help of the context menu opened by clicking 
the right mouse button and cursor on a field under the indicator. 

• Master is level control of the output signal during playback after mixing of tracks. 
This control is absolute, i.e. you always know, which level is set on output, and you 
can change its value in any moment. Change-over to the Master mode from any 
other control mode is made by clicking of the left mouse button under the indicator. 
Thus under this indicator there is a corresponding inscription. Control does not 
affect the waveform displaying. 

• Track is level control of one full track. This control is absolute also. Thus the 
inscription under the indicator is changed to Track. The amplitude of waveform 
changes proportionally to the control. 

• [Track] is level control of the fragment between green and red markers, on one of 
the tracks. This control is relative, i.e., having set a level of the fragment; you lose 
the information on its initial level and can continue changes only relatively last 
value. This operation is not irreversible, i.e., if to reduce a level of a fragment down 
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to 0, you always can raise it again, and thus the signal appears “from anywhere”. 
The track can be selected by clicking the mouse on the [] (Adjust level [] item 
of the Project window context menu. Thus the inscription under the indicator is 
changed for [Track]. The waveform amplitude changes proportionally to the 
control. 

• Segment is level controlling of an active segment. Each segment has a playback 
level setting, which is used during mixing it with other segments. The given 
control 
is absolute also, i.e., once having set a level of a segment; you can always modify 
and bring it back in its former state. Setting of the segment level is made by 
moving of the cursor to a violet frame of an active segment and pressing of the 
right button 
(if a segment is not active it should be first made active by clicking the left mouse 
button on it). Thus the context menu appears, from which you need to select 
Adjust segment level. Under the indicator the inscription Segment appears, 
and indexes 
of level values are set in the position corresponding to value of a level in each 
channel. The waveform of segment amplitude changes proportionally to 
controlling. 

• Volume - level of playback while listening. This setting does not affect audio on 
tracks. 

 

 

Fig. 3.42. The Indicator settings window 

• Properties. Opens the window Indicator settings (fig. 3.42).The following 
options are available: 

• Scale. This is the lowest sensitivity threshold of the indicator. The following values 
could be set: -20dB, -40=dB, -60dB and -90dB. 
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• Show peak values. Indication of peak values of signal. If this option is switched 
on, peak values are kept visible within 1 second. 

• Maximum (dB)- the value of maximal displayed level. 

• Scale correction (dB). Scale correcting parameter of the indicator. 

• Color settings - allow to adjust the indicator appearance. 

• Double scale range - a group of parameters, which allows to adjust a range of a 
scale (by default - a range between - 12 dB and 0 dB) for the increased double 
resolution, for more exact displaying of the signal level in this range. 

• Use default settings. If this option is switched on the settings made in this 
window are reset and also all parameters come back to values "by default". 

By pressing ОК the changes made in a window, are kept. Cancel results in previous 
settings keeping. 

Except for the context menu for switching a mode of level control it is possible to use 
virtual buttons of the corresponding toolbar (fig. 3.43). 

 

 

Fig. 3.43. The Toolbar of modes switching 

3.3.8.2 Normalization 

Normalization is a procedure of setting segment level, track level or entire project level. 
It is started by means of the Normalize segment command of the Project window context 
menu, called on any of segments (the effect of normalizer in this case concerns only selected 
segment), by means of the Normalize track command of the context menu of audio tracks 
control zone (a zone located between waveform and level-form) or with the help of the 
Normalize command of the Edit main menu (in this case normalization of the entire project 
is made; thus the inactive track does not participate in normalization (at two-channel editing) 
or tracks for which Mute is switched on at multichannel editing). This command calls the 
dialogue window Normalization (fig. 3.44). 

 

 

Fig. 3.44. The Normalization window 
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At start of normalizer the analysis and calculation of a segment first of all is made for 
definition of a maximum level in the left and right channel. Value of this predicted level (a 
peak) and peak position on a timebase are displayed in Level and Position windows. As the 
process of analysis is not momentary there is a indicator showing current analysis progress 
in the top part of the window. 

The units of measure used in this case, are dBFs; it means, that 0.00 dB corresponds 
to the greatest level possible; all calculated figures are either less, or are equal to 0. 

After analysis process is made, enter necessary level value in the Increase to window 
and press ОК. The difference between the entered signal value and calculated maximum will 
be used as amplification factor which is applied to a signal but in such a manner that the 
maximum level will not exceed the entered value. If the entered value will be less than 
calculated one on value the certain fragments of a segment will be “lowered" down to the 
entered level. 

If the mode Only increase is switched on there is no suppression of a calculated 
signal down to value of the entered level. If to switch on the Independent channels 
mode, normalization effects to the left and right channel separately, thus, of course, the 
stereo picture will be disturbed, but the left and right channel will be normalized to one 
absolute level. 

3.3.8.3 The “Rubber string” operating mode  

The level of a signal can be edited «locally» with the help of so-called «rubber string». The 
given mode entirely controlled by buttons of the corresponding toolbar (fig. 3.45). 

 

 

Fig. 3.45. Buttons for working with the level curve 

Method of the “rubber string” allows controlling audio level of entire track (the control 
can be made only on selected tracks). The mode of control is switched on by means of the 

 button. For switching on of this mode set this button in an active status. If control was 
already made before on a track the image of before created «rubber string» appears. The 
appearance 
of the track fragment in this case is resulted on fig. 3.46. 

 

 

Fig. 3.46. The level control with the help of “rubber string” 

For user’s convenience working with the «rubber string» the level of the raising or 
damping in dB entered in control process is displayed on the right edge of a track in dark 
blue figures. 
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As a matter of fact the «rubber string» represents a set of nodes connected by pieces 
of straight lines. Controls are carried out by moving nodes and pieces of straight lines 
between units. Nodes can be inserted on lines and deleted; at removal of nodes the break of 
a line in this point is eliminated. 

For realization of controls it is necessary to set nodes. For this purpose switch the button 

 on. Displaying of the «rubber string» is switched on by default - it is a green horizontal 
line 
at a level 0 dB; if up to the moment there were no controls with the help of the «rubber 
string» 
it contains no nodes. Further you can set as much as you want nodes by means of clicks of 
the mouse on those places of a line where it is necessary. Upon setting termination press the 
right button of the mouse (the mode of nodes addition can be switched off also by means of 
the same button on the toolbar). 

Control of a level is carried out by moving nodes and lines connecting them. At moving 
a line both nodes limiting it move simultaneously. 

For moving node set the cursor on this node, press the left button of the mouse and, 
holding it, move the node in any direction. If thus to press and hold the Shift key, moving 
is carried out strictly horizontally; with key Ctrl - only vertically. At positioning the cursor on 
the node, having pressed the right button and selected the only item Delete Gain Point, 
it is possible to remove it. For moving lines entirely set the cursor on a line; they move the 
same as nodes, with the same functions of keys Shift and Ctrl. 

Controls made are accompanied with changing of waveform in a window. 

To remove nodes and, consequently, to come back to initial control is possible using 

buttons  (between markers),  (on entire track) or corresponding context menu. The 

button  allows to apply all changes to the waveform; after application of changes to the 
waveform it is “fixed" in the project, but it is impossible to edit it anymore. 

3.3.8.4 Processing tools 

BCS Editor enables to use built in processing tools (plug-ins), developed by 3rd companies. 

Select the Process item of the menu Project to open the window DX Filters (fig. 
3.47). 

The fragment between green and red markers on the first selected track is selected for 
processing. For processing it is possible to use one or several plug-ins. It is possible to add 
the filter in process of processing with the help of the Add button. 

Work with filters as well as storing of the ready project is organized by a pre-set 
principle. In the Plugins window, opening after selection of the filter, it is possible to set 
sequence 
of filters manually or to use earlier stored sequence (pre-set) with the help of the dropping 
out list in the left top corner. 
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Fig. 3.47. DX Filters and Plug-ins windows 

The service menu of Plugins window contains the following items: Save preset; 
Create preset; Rename preset and Delete preset. The sense of these parameters is 
obvious from the name and does not need additional explanations. At executing of Create 
preset and Rename preset commands the user is offered to enter a new name for preset. 

The list of the plug-ins included in the given preset, with buttons of the list controls 
(allowing to add or remove a plug-in and also to move this or that processing up or down in 
the list) is listed below. 

To the right of the list on tabs there are controls of each connected plug-in. Parameters 
Bypass and Loop control general mode of filters. Button Play / Stop allows listening to 
results of plug-ins applications, and button Save applies processing to a track. 

3.3.9 Working with the text in BCS Editor 
3.3.9.1 Input of the text 

Entering the text in the Subject window is made in the special area limited by a grey 
rectangular. Text can be entered in this rectangular by means of: 

• Typing on a keyboard. 

• Inserting text file via File - Open. 

• Inserting text from the clipboard via Paste from the context menu. 

• Dragging text from MDB or the Files module. 

• Dragging text from the Fragments buffer (the fragment should have text or text - 
audio type). 

3.3.9.2 Inserting and editing of a sound 

• Creating of an audio insert in the Subject window (to insert a sound into a body 
of the text) could be done in several ways: 

• Dragging a fragment of audio type from the Fragments buffer. 

• Dragging audio file or project from MDB. 

• Inserting audio file from the clipboard. 

• Creating a new audio element via Create command of the context menu from the 
Subject window. 

In the simplest case audio fragment inserted in the Subject window is displayed as a 
light green strip where the name and duration of a fragment are specified. 

The place to inserted element by drag*drop is determined as follows: 



 
e.mail: info@tract.ru  e.mail : sales@digispot.eu  
 web :http//www.tract.ru  web :     www.digispot.eu   

  
  
 

 

 

 

Cooperation for Development of Hard-and Software for 
Audio and Video Broadcast Studios in East and West 
Europe. Design and Manufacturing of Studio Equipment  
for the Audio recording Industry and the in field of Video 
Postproduction. 

• If the cursor is positioned to any text line and the key Ctrl is hold, an audio insert 
splits this text below the selected line. 

• If the cursor is positioned to any text line an audio insert is formed above the text. 

• If the cursor is positioned to an empty field below text and other inserts, the insert 
is made in the end. 

• If the cursor is positioned on other insert the new fragment will be above inserted. 

Audio inserts can be moved by drag&drop method over the Subject window, 
rearranging thus, the sequence of a subject. 

It is possible to enter first and last words of the reporting in the insert name, it is 
needed often for broadcasting. It can be made, using the Edit audio item properties 
command of the context menu of an audio insert. After selecting of this command the 
Properties window opens. Use tab General to set values of the First line and Last line fields. 
Values of these fields also will be displayed in the Subject window. More details about 
properties of an audio element you can find in section 4. 

The audio insert can be listened directly in the Subject window. By double click on a 
line of an insert, you initiate playback of an audio track. After playback begins, red progress-
indicator on a line of a fragment testifies it, and also change of time duration of a fragment 
(towards to decreasing) happens. It is possible to play various parts of a fragment (in the 
beginning, in the end, on the middle of it, etc.). For this purpose click the left button of the 
mouse in various positions along a line of an insert. 

The audio insert can be taken for editing in the Project window from the Subject 
window. It means, that if you need to make any editing operations with the sound, you can 
move an insert in the Project window using the context menu of an audio insert (the Edit 
audio item). After you make necessary changes, close the Project window, and updated 
insert returns on that place, whence it was taken for editing. 

3.3.9.3 Stenography 

Stenography means the manual typing of text with synchronous listening of an audio track, 
in other words, printout of the text of an available audio track. It may be necessary to do, for 
example, for presentation of the report for content correction or for preparation of 
microphone folder. To start stenography load an audio file, for example, report, in the 
Project window, select an active marker and set it in the beginning of the report. 

To start playback of the report press F5 on the keyboard first time; after listening of the 
certain "portion" stop playback by pressing F5 key second time, then you can type all you’ve 
heard. The third pressing of F5 starts playback again, but with the small pre-roll from the last 
position so you could catch the continuation from the beginning and verify the end of the 
printed text. Time of pre-roll can be set individually, depending on skills of typing of the 
operator with the help of the corresponding toolbar (for more details go to section 4). The 
cycle repeats repeatedly, until the text is typed. You can move a marker over the waveform 
of the report, typing selective parts of it. 

3.3.9.4 Playback of a subject 

The Subject window of the BCS Editor is completely identical to the Announcer window of 
the DIGISPOT® II broadcasting system; what allows to prepare a subject completely for 
airing and 
to transmit it in finished form through MDB DIGISPOT® II to the schedule of broadcasting 
station. Playback of prepared subject can be made both from BCS Editor, and from 
broadcasting station through the Announcer window. 
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Playback of a subject looks as follows. After the subject is ready, i.e. all texts are typed 
in (introductions, microphone texts), and also all sounds are inserted and edited (jingles, 
reports, songs, etc.), it is necessary to press the Beginning button (a green arrow in the 
left top corner of the Subject window), in result the subject will be ready for playback. 
First element (audio insert or text) will appear in the top of the window and the button Next 
will show name of the first audio track in the queue. 

Now you can read the text in a microphone. Upon finishing of reading press the Next 
button, the loaded audio track starts to playback, then you can read the next text and the 
next audio item will appear in the Next button; thus, entire subject is played back. 

At playback of a concrete insert, the progress-indicator of green color appears on its 
line and there is a time countdown, showing, when the audio insert will be over. For the 
same purpose you have the last lines of an audio track typed in the name of an insert. To 
stop playback press the Stop button. 

If the text is large and does not fit entirely into the area of a window, it is possible to 
use scroll controls on the right in the Subject window. But as scrolling moves the text 
smoothly, what is not absolutely convenient, it is possible to take advantage of the Next 
button, in this case the inscription “next page” appears on it. 

The Setup button allows setting of a physical audio output of computer for that 
application, i.e. to determine, through which physical output the subject will be played back. 

3.3.9.5 Recording of a subject into audio file 

One more very important method is mixing of a text and audio subject in one audio file. 
There are lot of examples of work in which this useful skill can be necessary. For example, 
the journalist prepared news release as the texts, necessary jingles and audio reports, and 
wants 
to broadcast it as one audio file in order not to take part in broadcasting process. For this 
purpose he should record his voice together with already available sounds. Another example 
is compilation of broadcasts. There are prepared reports, interviews, comments, songs; 
i.e. a ready discrete audio material, the text of introductions, comments, speech transitions, 
etc. are typed in. All these are made in a certain sequence in the subject window. Now 
it is necessary, while the announcer is present in studio, to record text, alternating it with 
ready sounds, for one passage. 

For these purposes it is necessary to create a setup shown on fig. 3.48. 

After that it is necessary to open the Project window and to prepare the mode of 
record. Combining a record mode in the Project window and the mode of playback in the 
Subject window it is possible to record entire subject on a track of the sound editor. 

 



 
e.mail: info@tract.ru  e.mail : sales@digispot.eu  

eb :     www.digispot.eu web :http//www.tract.ru  w    

 

 

Cooperation for Development of Hard-and Software for 
Audio and Video Broadcast Studios in East and West 
Europe. Design and Manufacturing of Studio Equipment  
for the Audio recording Industry and the in field of Video 

  
  
 

 

Postproduction. 

 

 BCS Editor  
SUBJECT window  PLAYBACK mode 
PROJECT WINDOW, RECORD mode 

Control 

Microphon

Mixing console 
SUBJECT window PLAYBACK mode 
PROJECT window, RECORD mode 

Fig. 3.48. The circuit for recording of subject in audio file 

This mode is especially comfortable, when mixing console has a special button field for 
remote control of BCS Editor. 

3.4 3.4. Variants of the project storing 
Very important question is how and where it is possible to store the created material for 
using 
it later. 

It is possible to store a working material in several methods depending on what you 
want to find in the result. The main question which it is necessary to answer at the moment 
of storing is the following: in what format, project, subject or an audio file, you have to store 
your work and where it will be stored - in the file structure or in MDB. 

Storing is made with the help of items of the File menu: Save, Save to file, Advanced 
- Save subject to FILE, Save to DB and Advanced - Save subject to DB. 

• Save  - saves collected working material over initial one. It is used in the case if the 
project is already stored or it was opened from MDB or from a disk. 

• Save to file- saves working material in a file on a disk, selected by the user, giving 
an opportunity to set file format, audio format and other additional parameters 
(what to save, name, type, category, author, etc.). 

• Advanced - Save subject to FILE- saves working material in the file selected by 
the user on a disk as a subject. The same as Save to FILE, this command allows 
setting some additional parameters. 

• Save to DB- saves working material in MDB, giving an opportunity to set file 
format, audio format and other additional parameters (what to save, name, type, 
category, author, etc.). 

• Advanced - Save subject to DB- saves working material in MDB as a subject. 
By analogy to other commands of storing, allows setting an audio format and other 
parameters. 

3.4.1 Presets for storing 

Storing and exporting of working material are realized on the basis of presets technology 
(presets). The system remembers options entered by the user under the specified name and 
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allows changing them as required. The user can create new presets and delete already 
unnecessary ones. There are two standard presets: Default and Save As. The Default 
preset is used for new projects (subjects) if they are stored at the first time (default 
properties of the project). If storing is repeated you can use the preset Save As or those 
under which the project was stored last time. Save As preset it is used in following cases: 

• If after project creation, but prior to first storing, the user set any parameters in 
the Properties window (the Project properties item) of the main menu 
Project). 

• If the project is loaded from a disk. 

• If the project is loaded from MDB. 

The administrator can change preset properties by selecting Edit FILE save presets 
item or Edit DB save presets submenu Presets of the File main menu. It is possible to 
edit current presets in the appeared dialogue (set the new name, determine what fields and 
properties of the project the user can change at storing), to create new or to remove 
already unnecessary. The detailed description of process of presets options see in section 4. 

3.4.2 Save subject to FILE 

Fig. 3.49 shows appearance of the window of export of a working material to a file which 
opens after selecting Save to FILE command, located in the File menu. 

The description of parameters controlled in this window is resulted below: 

• Presets. User has an opportunity to select preset from the list created before. 

• The group of parameters Properties allows to operate stored parameters of the 
project, including: 

o Name - the name of the project. It is possible to enter manually or to generate 
from file name by pressing the button From file name. 

o Type - type of audio material. In case of storing or export to MDB this field 
determines, into which section of DB this material will get and is obligatory 
to filling. In other cases it is possible not to fill in this field. 

o Category - determines category of MDB to which the given material concerns. 
Has sense at storing or export to MDB, in other cases it has an informative 
function. 

o Author - the list of authors of a material. 

o Artist - the list of performers of a material. 
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Fig. 3.49. Save to FILE window 

o Archive item – this parameter comes to BCS Editor from DJIN and determines 
belonging of a file to an archive. 

o Ready for air - the parameter inherited from DJIN and determining readiness 
of an element for broadcasting. 

o Air date - the parameter inherited from DJIN and specifying prospective date 
of broadcasting. 

o By pressing More details button the user opens standard dialogue Properties. 

o File - in this field an actual location of a file in which storing will be made 

is displayed. To choose a new location press the button  (standard Windows 
window of selecting files opens where the desirable name and location of a file 
is necessary to set). 

• File format. Allows to choose, in what format the file to be stored - wav, mpeg 
or Project (*.tpr). In order not to store unnecessary material, at same group there 
is the Only used audio to *.tpr parameter, allowing to “throw out" not used 
audio-fragments from the stored project or materials, forgotten for any reasons. 

• Options - the group of parameters determining which audio material to store - 
project, selected sound tracks, fragment between the markers, played back tracks. 
Additional function is possibility to cut out silence in the beginning and in the end 
(present only at storing). 

• Audio format - the group of parameters determining in which audio format the 
material is stored. If the Standard item is selected, the format accepted standard 
for all working complex is used (it can be set on a tab Audio format of the Global 
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settings window of the Service menu. If the user needs to store material in 
another format, he needs to select individual (Custom) type of a format and to 
set the necessary parameters independently in an opening standard control 
window. 

The Save to FILE command stores working material either as the project, or as an 
audio file. To store it as a subject, select the Save subject to File command from 
subgroups of commands Advanced of the File menu. The window Save subject to FILE 
opens in this case. The parameters accessible for editing in this window have the same 
sense, as similar items in the Save to FILE window (fig. 3.50). 

 

 

Fig. 3.50. Save subject to FILE window 
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Fig. 3.51. Save project to DB window 

The parameters adjusted in this window, in many respects are similar to parameters 
of storing of the project in a file (see section 3.4.2). The single additional parameter is the 
Select DB item. The MDB window opened by pressing of this button (fig. 3.52) allows 
selecting an element where a working material is to be stored, from MDB. 
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Fig. 3.52. The window of selecting of MDB item 

Overwrite / Create new- in case of coincidence of stored material with already 
available in MDB, the given parameter allows to update of its version, i.e. allows both to 
create a new element, or to rewrite already existing (for example, in a case if the material 
from a DB has been taken for editing). 

The Save to DB command stores working material either as the project, or as an 
audio file. To store it as a subject select the Save subject to DB command of Advanced 
subgroups of commands of the File menu. Save subject to DB window opens in this case. 
The parameters accessible to editing in this window have the same sense, as similar items 
in the Save subject to DB window (fig. 3.53). 

 

 

Fig. 3.53. Save subject to DB window 

3.5 Working with the Buffer of Fragments 
As it was mentioned above, BCS Editor has an opportunity to use the buffer of fragments 
(Fragments) (fig. 3.54) for storage of intermediate working material. What material can 
be loaded in the Fragments and in what form is explained in details in section 2. Here 
we discuss the question how it is possible to load or unload, and also to edit fragments from 
the buffer. 

 

 

Fig. 3.54. The Fragments window 

3.5.1 What and how can be loaded in the buffer as fragments? 

It is possible to load elements from the Project window, from the Subject window or 
from MDB DIGISPOT® II into the Fragments; the current project or subject can be loaded 
entirely from file structure. 
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Loading is carried out both by dragging, or through the context menu with the help 
of Element → Fragment items. 

 

 

Fig. 3.55. Loading into Fragments 

From the Project window it is possible to load: 

• Track entirely. Open the Project window context menu and select Track → 
Fragment item. The dialogue window offers current name, you can change or keep 
it (fig. 3.55) after that the track is copied and forms a fragment of the buffer 
of an audio type with the certain name. 

• Selected segment. Select any segment, open the context menu of a segment and 
select Segment → Fragment item. The segment will be copied in the Fragments 
buffer as an audio with a name of the selected segment. To rename a new 
fragment, take advantage of the Fragments context menu. 

• An interval of a track between green and red markers. Set markers, open the 
Project window context menu and select Track [] → Fragment item. At copying 
in the Fragments buffer the name by default will be offered; it is possible to 
change it (fig. 3.55). After confirmation of a name, the new fragment of type audio 
is formed. 

It is possible to load following elements from the Subject window in the Fragments 
buffer:  

• An audio insert, having dragged from the Subject window in the Fragments 
buffer with keeping of a name. Thus the fragment of an audio type is formed. 

• Text record, by positioning of cursor on heading of record, left mouse button click 
and dragging a record in the Fragments buffer. The fragment of a text type is 
formed. 
At dragging the name by default is offered which can be corrected (fig. 3.55). 

• A set of text records. Using Shift key and the right mouse button together, select 
records, clicking them on heading then drag them in the Fragments buffer. The 
fragment of set of texts type is formed. At dragging the name by default is offered, 
it can be corrected. 

Audio content of the current project can be placed in the Fragments buffer from the 
Project main menu with the help of the Create fragment item of menu. The fragment of 
audio type is formed. 

From MDB DIGISPOT® II in the Fragments buffer you can get: 
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• Audio file or project. Open MDB, select necessary audio file or project and drag 
it in the Fragments buffer. The fragment with the same name of audio type 
is formed. 

• Text file or subject. Open MDB, select necessary text file or subject and drag it in 
the Fragments buffer. The fragment with the same name of the text type or  text 
- sound type is formed. Thus all records which are included in a subject will be 
presented 
as entire record. 

3.5.2 How to load different types of fragments into the Project window and Subject window? 

The Fragments buffer is a universal place to keep initial materials and intermediate results 
of work within fast reach. During work there can be a necessity to load fragments of 
different types both in the Project window, and in the Subject window for working over 
the current project or subject as a whole. In this case it does not matter to the editor, from 
what the element of the Fragments buffer is formed initially; at its locating in this or that 
"place" of the project only its type plays a role: text, audio or text and audio. 

BCS Editor gives following methods of use of the elements stored in the Fragments 
buffer: 

• Fragment of audio type is transported to the Project window. The fragment of 
audio type can be dragged from the Fragments buffer to the Project window. 
Select 
an audio fragment and, holding the left button of the mouse drag it on the 
necessary track; at occurring of the cursor of the mouse on a track it transforms 
into a strip – the marker showing an initial position of an insert. By selecting 
position and releasing the button of the mouse we insert a fragment on a track. If 
an audio fragment 
is formed from the project with several tracks and lot of segments, it is 
represented 
as entire mixed segment after its inserting on a track. 

• Fragment of audio type is transported to the Subject window. The fragment of 
audio type can be dragged from the Fragments buffer to the Subject window. 
Select 
an audio fragment and holding the left button of the mouse drag it to the 
necessary place of the Subject window. At dragging all rules of sound inserts 
arrangement including Ctrl key rule, are valid. 

• Fragment of text type is transported to the Subject window. The fragment of 
text type can be dragged from the Fragments buffer to the Subject window. 
Select the text fragment and, holding the left button of the mouse drag it to the 
necessary place of the Subject window. If you position a fragment over audio 
insert, will be inserted above, forming new text record. If you position a fragment 
to a line of text record and hold Ctrl key, new text record “cut" the existing on two 
and will be inserted below selected line. If Ctrl key was not kept, new text record 
will be created above. Also the text can be inserted into a Subject window from 
file structure, selecting Paste file item in the context menu. 

• Fragment of text and audio type is transported to the Subject window. The 
fragment of text and audio type (in most cases it is earlier created subject) can be 



 
e.mail: info@tract.ru  e.mail : sales@digispot.eu  
 web :http//www.tract.ru  web :     www.digispot.eu   

  
  
 

 

 

 

Cooperation for Development of Hard-and Software for 
Audio and Video Broadcast Studios in East and West 
Europe. Design and Manufacturing of Studio Equipment  
for the Audio recording Industry and the in field of Video 
Postproduction. 

transported entirely to the Subject window. It is inserted above the selected place 
as text records and audio inserts. 

Similar operations can be executed with the help of the Create fragment command of 
the Project menu. The item of the menu allows to create a fragment from the current 
project 
or subject and to place it in the Fragments window. During creation a new name 
of a fragment is offered to enter. 

3.5.3 Editing fragments 

The fragment of any type can be taken from the Fragments window for editing. It means, 
that if you need to execute any editing operations with the sound or correct the text, you can 
move 
a fragment in the Project window or to the Subject window if it is a text fragment, using 
Edit item of the context menu of the buffer. After you made necessary changes, close the 
Project window or Subject window; the updated fragment returns on that place, whence 
it is taken for editing. 

It is necessary to know the following: 

• Text and audio subject  gets on editing as the text with audio inserts; 

• At sending on editing of a fragment of audio type, added earlier in the form of the 
project, it opens as the project, i.e. with the certain number of tracks and 
segments. 

In other words it is possible to describe editing procedure as following: for example, you 
work over any project or subject, and you need to change contents of any fragment (edit, 
type). You take it on editing, opening a new window of the Project window or Subject 
window, edit and after closing a window, come back to the basic work. Thus, editing is an 
availability of local use of the text and audio editor during the main work. 

As it was mentioned earlier, you can work simultaneously over several projects or 
subjects at once. The Fragments window thus is one for all these works. It is not an 
accessory of the concrete project or subject; it an accessory of the given workplace. 

NOTE 

The operator himself should watch contents of the Fragments window. He should delete already unnecessary 
fragments by himself. A practical example: if in work over the subject the radio journalist constantly uses certain 
jingles and text intermediates, he can constantly hold them within reach in the Fragments window, using them 
in each new work. 
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4 Configuring BCS Editor 
4.1 The main menu of BCS Editor  
 

 

Fig. 4.1. The main menu of BCS Editor  

The main menu of BCS Editor (fig. 4.1) contains the following items: 

• File - a set of commands for working with projects and subjects files, and also 
some functions of BCS Editor administration; 

• Edit - clipboard handling commands and other editing functions; 

• Project – project handling commands; 

• View - a group of commands, allowing to adjust appearance of working space, 
in particular, toolbar; 

• Service - commands for adjustment of working environment; 

• Window - the standard menu of windows control; 

• Help. 

4.1.1 The File menu 

As it was mentioned above, projects and subjects commands are included in this item of the 
main menu (fig. 4.2): 

 

Fig. 4.2. The File menu 

• New project. This command creates a new project window: Project window with 
one audio track opens. The Subject window is closed by default. The name 
"noname" 
is assigned to the new project; if you want to rename the project, you can make 
it in the Properties window (Project,  Project properties item). 

• Open. This command opens already existing project or subject. The standard file 
structure window is opened with a folder used previously. It is possible to select 
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project or subject stored earlier in it. In result the window of the project or subject 
opens, in which the whole picture of the project at the moment of its last saving 
is restored. 

• Save. This command saves project or subject on a hard disk. Saving is done 
under the same name and in the same folder where the source file belongs to (i.e. 
the file 
is overwritten). 

• Save to FILE. This command saves the project in the file specified by the user. 
For more details about it see section 3. 

• Save to DB.  This command saves the project as a new or already existing 
element 
of DB. For more details about it see section 3. 

 

  

Fig. 4.3. The File menu, submenu Advanced 

• Advanced. It is a group of commands for working with subjects (fig. 4.3; for 
more details on commands of this submenu see section 3): 

o Save subject to file- saving of created material in a file as a subject. 

o Save subject to DB- saving of created material in MDB as a subject. 

o Presets - group of commands controlling presets of saving of the created 
material in files or MDB as a subject. For more details about commands of this 
group see Presets of storing section of this chapter. 

� Save subject to file presets …- editing of save presets of the created 
material in a file as a subject. 

� Save subject to DB presets …- editing save presets of the created 
material in MDB as a subject. 

 

  

Fig. 4.4. The File menu, Presets submenu 

• Presets - the group of commands controlling presets of saving of the created 
material in files or MDB as an audio file or project (fig. 4.4). For more details 
about commands of this group refer to Save Presets section of this chapter; more 
details about saving of a material as the project or an audio file are given in 
section 3. 

o Edit FILE save presets- editing of presets of saving of the created material 
in a file as a project or an audio file. 
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o Edit DB save presets- editing of presets of saving of the created material 
in MDB as a project or an audio file. 

• Login- having selected this item, you can log into system under another name, 
i.e. to enter new login (user’s name) and password. 

 

  

Fig. 4.5. The login window  

• Administration- this command is accessible only to the administrator who can 
give any user the certain rights for working with the schedule or MDB. In details the 
system of administration is described in the Description of DJIN software 
(DIGISPOT® II). 

• Restart- this command restarts the application. 

• Exit- exiting from BCS Editor application and closing of a workplace. 

4.1.2 The Edit menu 

 

Fig. 4.6. The Edit menu 

• Undo - this command cancels last editing operation. The cancellation of operations 
is made in the order, reverse to their application. Number of operations which can 
be cancelled, is not limited; i.e. consistently cancelling all operations, it is possible 
to come to initial status of the project. All operations, except for playback level 
control of a track and master - level settings are subject to a cancellation. 

• Redo - this command returns the editing operation cancelled earlier. Return of the 
cancelled operations is made in the same order in what they originally were applied 
(i.e. in the order, reverse to their cancellation). The command is accessible only 
in a case if one action has been cancelled at least. 
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• Cut [] - cutting of the track fragment between green and red markers to the 
clipboard. This command influences segments even if their displaying is switched 
off: segments with red and green markers are spliced in the positions of markers, 
segments located behind red marker are moved left to the length of cut fragment, 
and the crossfade of segments takes place in the green marker position. 

• Copy [] - copying of the track fragment between green and red markers to the 
clipboard. 

• Delete [] - deleting of the selected fragment of track without copying to the 
clipboard. Segments with red and green markers are spliced in position of 
markers; segments located behind red marker are moved left to the length of cut 
fragment, and the crossfade of segments takes place in the green marker position. 

• Clear [] - erasing audio from the selected part of the track. This operation differs 
from the Delete command by the fact that the length of source audio material 
does not change, since cleared fragment of track is filled by silence. 

• Paste - inserting contents of the clipboard on a track from blue marker position. 
Thus the segment on which blue marker is located, is spliced, in this place the 
fragment from the clipboard is inserted; and the segments located to the right are 
shifted to the right for the length of an inserted fragment. 

• Mix - imposing of the contents of the clipboard to the track starting from the blue 
marker position (as a result a new segment appears, as in case of Paste). Thus 
the new fragment is mixed with already existing audio. After execution of this 
command the imposed fragment is displayed in the waveform window with black 
color, and mixing zone is displayed with grey color, it is also displayed by a red 
strip in a zone 
of “crossfades and fades”. 

• Cut segment - cutting of the segment selected on a track to the clipboard. The 
segments located to the right are moved to the left for the length of the cut 
segment; automatic crossfade is created between the segments located to the 
right and to the left of cut segment. 

• Copy segment - to copying of the segment selected on a track to the clipboard. 

• Delete segment - removal of the selected segment on a track. The segments 
located to the right, are moved to the left for the length of a cut segment. 
Automatic crossfade is created between the segments located to the right and to 
the left of cut segment. 

 

4.1.3 The Project Menu 

  
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Fig. 4.7. The Project Menu 

• Create track- this command allows to add one more track to the project. 

• Delete selected tracks- this command deletes selected tracks from the project. 

• Normalize - normalization of the project as a whole. The inactive track does not 
participate in normalization (at two-channel editing) or tracks which Mute mode 
is switched on, at multichannel editing. For more details about normalization refer 
to section 3.3.8. 

• Create fragment- the given menu item allows to create a fragment from the 
current project or subject and to place it the Fragments window. Thus it will 
be offered to enter a new name for new formed fragment. For more details about 
Fragments window refer to section 3.5. 

• Project properties - this command opens a window which allows to describe the 
project, otherwise, to add or change metadata describing the project; to specify 
storage place both in file structure, and in MDB. More details about project 
properties option you can read in this section below. 

• Merge tracks  - this menu item allows to combine (to merge) several soundtracks 
or their parts in a combined segment on a new track. For more details about 
merging of tracks refer to section 3.3.6. 

• Block edit mode - this item is intended for work with files with MP2 extension; 
it is preferable in case of editing without making mixing and fades. In this case 
merging is not followed by decompression and further compression of a signal. If 
this mode there is no decoding of audio to РСМ and then back coding into MP2 file. 
BCS Editor itself packs a new file. Thus accuracy of editing is equal to length of MP2 
block (1152 samples). 

• Process - opens the menu of processing tools (plug-ins). For more details about 
plug-ins refer to section 3.3.8. 

 

 

 

4.1.4 The View Menu 
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Fig. 4.8. The View Menu 

View menu suggests optional controls to be accessible from the toolbar and control 
panel. 

• Status - displaying of a status line in the bottom part of a program window. 

• Transport - displaying of the control panel of playback of audio track. 

• Edit - displaying of the panel of editing operations. 

• Devices - displaying of an indication line of devices and modes settings. 

NOTE 

Settings in this zone should be performed only by qualified personnel. The user is not recommended 
to change them. 

• Level curve - displaying of virtual buttons for picturing of a level on a toolbar. 

• Level adjustment - displaying of virtual buttons for selecting of modes of level 
adjustment on a toolbar. 

• Scale - displaying of the panel of scale selection on a toolbar. 

• Tracks - displaying of the tracks control board. 

• Shuttle - displaying of the panel of indication and regulation of playback speed. 

• Fragments - displaying of the Fragments window. 

• Schedule - displaying of the Schedule window. 

• Files - displaying of file structure window (the Files window). 

• Data base displaying of the MDB window (MDB module). 

 

 

 

 

 

4.1.5 The Service Menu 

  

Fig. 4.9. The Service Menu 
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• Settings - this command opens a window of parameters setting of BCS Editor. More 
details about these settings are given below in this section. 

• Global settings- this command opens a window of settings of general parameters 
of entire DIGISPOT® II system – storage catalogue, formats of a material, etc. This 
item, 
as a rule, is seldom re-adjusted, but its changes concern all workstations of a 
complex. More details about settings are given below in this section, and also in the 
manual 
of DJIN application. 

• Workstation settings - this command opens a window of setting of parameters, 
general for all programs of DIGISPOT® II system, set on the given workstation. 
More details about settings are given below in this section, and also in the manual 
of DJIN application. 

• Show error log- this command opens the Messages BCS Editor window. The 
window contains two tabs: Text messages and Test value, used basically 
by developers at complex settings. 

• Customize keyboard- this command opens a window of hot keys settings in BCS 
Editor. More details about these settings are given later in this section. 

• Fonts - this command opens a window of fonts’ settings for displaying in various 
fields of windows of BCS Editor. More details about these settings are given later in 
this section. 

 

 

Fig. 4.10. The Settings of Antex devices and mixers window 

• Antex- this command opens the Setting of Antex devices and mixers window, 
used by developers for complex settings. It is not recommended to change 
parameters of this window on your own. 

• Mixers - this command opens the Mixers control setup window. More detailed 
about parameters set in this window are given later in this section. 

• Delete unused waveforms - the given item of the menu allows to delete audio 
tracks which are not used in the project. Principles of deleting of unused material 
are described in details in the DJIN manual. 
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4.1.5.1 The Window menu 

 

Fig. 4.11. The Window menu 

• Cascade - this command allows to arrange all opened windows of projects in such 
way that they were imposed one on another with a small shift. Thus the top 
window 
is visible only; but it occupies the greatest possible area. 

• Split- this command allows to arrange all opened windows of projects as a 
mosaic. Thus all windows are visible, but the more windows are opened, the each 
of them falls at less area. 

• Sort- this command allows to put all minimized windows in proper order. 

• The list of opened windows - further in the menu the Window follows the list 
of all opened windows providing fast approach to any opened project. 

4.1.5.2 The Help menu 

 

Fig. 4.12. The Help menu 

• About - this command opens a window containing the information on program 
version number and contacts to developers. 

• Components and licenses- this command opens the Components window (fig. 
4.13), containing the information on all installed modules of the program. 
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Fig. 4.13. The Components window 

• Look for updates - command of updates control (if those are stipulated). 

4.2 Context menus of BCS Editor  

4.2.1 The Project window menu in a mode of editing by markers 

• Copy- duplicates a command Copy [] of the Edit menu. 

• Cut- duplicates a command Cut [] of the Edit menu. 

• Paste -duplicates the same command of the Edit menu. 

• Paste []- the special version of the Paste command which carries out an inserting 
of a material instead of a fragment selected by green and red markers (more 
details about this command are given in section 3,  Editing by markers). 

 

Fig. 4.14. Context menu of the Project window 
in a mode of editing by markers 

• Mix, Delete - duplicate same commands of the Edit menu. 

• Clear- duplicates the Clear [] command of the Edit menu. 

• To last track [] - this command "sends" the selected fragment to the last track of 
the project; it is present only in the context menu of the Project window, both in 
a mode of editing by markers, and in a mode of editing by segments (in the latter 
case - only by a call of the menu not from area of an active segment). 

• Place file- this command imports an audio file on a track. More details about this 
command are given in section 3.2. 

• Record file - this command calls a window of audio material recording. More details 
about this command are given in section 3.2. 

• Adjust level [] - this command selects a track for displaying on a level indicator. 
More details about this command are given in section 3.3.8. 

• Tracks → Fragment- this command creates a fragment from an active track and 
places it for next use in the Fragments window. More details about this command 
are given in section 3.5. 
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• Tracks [] → Fragment- this command creates a fragment for the Fragments 
window from a material limited by green and red markers. More details about 
this command are given in section 3.5. 

The appearance of the context menu of the Project window in a mode of editing by 
markers does not depend on window area from which it is called. 

4.2.1.1 The menu of the Project window in a mode of editing by segments 

Following commands are present in the context menu called in the Project window in a 
mode of editing by segments from any point of the window excluding those on the selected 
segment (fig. 4.15): 

• Copy, Cut, Clear - duplicate Copy [], Cut [] and Clear [] commands of the Edit 
menu and similar commands of the context menu of the Project window in a 
mode 
of editing by markers. 

• Paste, Delete, Mix - duplicate the same commands of the Edit menu and 
commands of the context menu of the Project window in a mode of editing. 

 

Fig. 4.15. The context menu of the Project window  
in a mode of editing by segments 

• Paste [] - duplicates the similar command of the context menu of the Project 
window in a mode of editing by markers. 

• Split by marker – this command splits a track on two segments in a position 
of an active marker (see more details in section 3.2, Editing by segments). 

• Split [] - this command forms a new segment between markers, i.e. carries out 
simultaneously two splittings (see more details in section 3.2, Editing by 
segments). 
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• Group segments [] - this procedure unites all segments between markers (green 
and red), in one. More details about this command are given in section 3.2, Editing 
by segments. 

• Create segment [] - this command unites all segments between markers (green 
and red), in one. More details about this command are given in section 3.2, Editing 
by segments. 

• To last track [] - this command "sends" the selected fragment to the last track of 
the project; it is present only in the context menu of the Project window, both in 
a mode of editing by markers, and in a mode of editing by segments (in the latter 
case - only by a call of the menu not from area of an active segment). 

• Place file- this command imports an audio file on a track. More details about it are 
given in section 3.2. 

• Record file - this command calls a window of recording of audio material. More 
details about it are given in section 3.2. 

• Adjust level [] - this command selects a track for displaying on level indicator. 
More details about it are given in section 3.3.8. 

• Tracks → Fragment- this command creates a fragment from an active track and 
places it for next use in the Fragments window. More details about it are given 
in section 3.5. 

• Segment window - this command opens a window of the list of segments 
(Segments on track N), where N is a number of a track). More details about it 
are given in section 3.3.5. 

Following commands are present in the context menu called in the Project window 
in a mode of editing by segments by right button click of the mouse on the selected segment 
(fig. 4.16): 

• Copy segment, Cut segment, Delete segment - duplicate same commands of 
the Edit menu (More details about it are given in section 4.1). 

• Adjust segment level - this command selects a segment for displaying on level 
indicator. More details about it are given in section 3.3.8. 

 

Fig. 4.16. The context menu of active segment 

• Segment → Fragment- this command creates a fragment from the selected 
segment for placing it in the Fragment window. More details about it are given in 
section 3.5. 
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• Segment properties - this command calls the Segment properties window 
where it is possible to set a name of a segment, and also types of fade-in and 
fade-out (linear or logarithmic). 

• Segment window  - duplicates a similar command of the context menu of the 
Project window in a mode of editing by segments in a case if the menu is called 
from any point of a window which is not laying on an active segment. This 
command opens a window of the list of segments (segments on track N), where 
N is a number 
of a track). More details about it are given in section 3.3.5. 
4.2.1.2 Context menus of the Subject window 

The context menu called from any point of the Subject window, which is not laying on a 
sound insertion (fig. 4.17), contains the following commands: 

 

 

Fig. 4.17. The context menu of the Subject window 

• Undo - this command cancels last operation of working with the text. Also, 
depending on contents of the clipboard there can be commands:Paste (allows to 
insert 
a fragment of the text from the clipboard),Cut(allows to cut out a fragment of the 
text and to place it in the clipboard) and Copy(allows to copy a fragment of the 
text and 
to place it in the clipboard). 

• Create new audio item- this command creates a new audio item; more details 
about it are given in section 3.3.9. 

• Print- this command allows to print out the text fragment located in the Subject 
window. 

• Print preview- this command opens a window of preliminary viewing of the text 
(fig. 4.18), allowing to look through a text subject in the convenient form, and 
also 
to print it out. 

The context menu of an audio insert in the Subject window (fig. 4.19) contains the 
following commands: 

• Cut- the command cuts out an audio insert from the Subject window. 
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Fig. 4.18. The Print preview window 

• Copy- copies an audio insert from the Subject window, placing it in the clipboard. 

• Delete - this command deletes an audio insert. 

 

  

Fig. 4.19. The context menu of an audio insert in the Subject window 

• Undo - cancels last action. 

• Create new audio item- creates a new audio item; more details about it are given 
in section 3.3.9. 

• Edit audio item- opens an audio item for editing. More details about it are given 
in section 3.3.9. 

• Edit audio item properties- opens a window of adjustment of properties 
of an audio insert. More details about it are given later in this section. 

• Print- print out the text fragment located in the Subject window. 
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• Print preview- opens a window of preliminary viewing of the text (fig. 4.18), 
allowing to look through a text subject in the convenient form, and also to print it 
out. 

4.2.2 The context menu of the Fragments window 

• Play - starts listening of an audio insert. Note that listening can be organized 
in another way, making double click on a line of a sound fragment. After starting 
of listening process the red indicator testifies its status and change of its duration 
time of a fragment on decrease on a fragment line. The fragment can be listened 
in different places (in the beginning, in the end, in the middle, etc.); for this 
purpose click the left key of the mouse in the necessary positions of a fragment 
line. 

 

 

Fig. 4.20. The context menu of the Fragment window 

• Edit -takes fragment for editing. More details about editing items of the 
Fragments window are given in section 3.5. 

• Create copy copies an item from the list in the Fragments window, placing it in 
the clipboard. 

• Delete - deletes fragment from the Fragments window. If you want to remove 
several fragments, use the Shift key, select necessary fragments and delete them 
with the help of the given command. 

• Properties - opens a window of properties of an item of the Fragments window. 
More details about properties of a fragment are given below in this section. 

• Refresh- updates contents of the Fragments window. Execution of this 
operation is necessary after return of items of the Fragments window after 
editing. (In a case if the context menu is called in the Fragments window from 
the area which does not contain fragments, it is the only command available). 
4.2.2.1 The context menu of area of indication 
and adjustment of project duration 

• Normalize track- this command calls the Normalization window. More details 
about process of normalization are given in section 3.3.8.  

• Tracks → Fragment- creates a fragment from an active track and places it for 
next use in the Fragments window. More details about work with the 
Fragments window are given in section 3.5. 
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Fig. 4.21. The context menu of area of indication 
and adjustment of project duration 

• Shift tracks up, Shift tracks down - shift selected tracks up and down 
correspondingly. 

• Delete selected tracks- deletes selected tracks. 

• Hide tracks - hides selected tracks. Remember, that even the hidden track can 
be active or inactive; all changes concerning active tracks, can be reflected on it. 

• Properties - opens the Track properties window. More details about parameters 
which can be set in this window are given later in this section. 

4.3 4.3 BCS Editor Toolbars 
 

 

Fig. 4.22. BCS Editor Toolbar 

•  - editing mode settings Button. If this button is pressed, the mode of displaying 
of segments is activated; if is no - the mode of editing by markers is activated. 

4.3.1 Standard panels of editing and cancellation of actions 

 

Fig. 4.23.The standard panel of editing 

•  - cut out a fragment between green and red markers from a track to the 
clipboard. Segments on which red and green markers are located, are split in 
markers positions; the segments following red marker, are shifted to the left for 
length of a cut fragment, and a crossfade is created in a position of a green marker. 

•  - copy a fragment between green and red markers to the clipboard. 

•  - insert contents of the clipboard on a track from a blue marker position. Thus 
a segment, on which the blue marker is located, is split in this position; the 
segments located to the right, are shifted to the right for a length of an inserted 
fragment, and the fragment from the clipboard is inserted into this place. 
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Fig. 4.24. The standard panel of cancellation of actions 

•   - cancels last operation. Cancellation of operations is made in the order 
reverse 
to their application. 

•  - To return the cancelled operation. Returning of the cancelled operations is 
made in the order, reverse to cancellation of these operations. 

4.3.2 Panels of scaling and positioning of the screen 

 

Fig. 4.25. The panel of fast moving of the screen 

•  - moves the screen to the beginning of a track. 

•  - moves to the left for one screen. 

•  - moves to the right for one screen. 

•  - moves the screen to the end of a track. 

 

Fig. 4.26. The scaling panel  

• , , , ,  - scale setting of waveform displaying. Allow to show 5, 10, 
20, 30 or 60 seconds of waveform correspondingly. 

•  - displays entire waveform on a screen. 

•  - Increase scale of waveform displaying. 

•  - Reduce scale of waveform displaying. 

•  - Switching on of a scaling mode from a left edge of waveform. If this mode 
is switched on, any changes of scale will be carried out, "making a start" from a 
left edge of a fragment. 

•  - Switching on of a scaling mode from the center of waveform. If this mode 
is switched on, any changes of scale will be carried out, "making a start" from the 
center of a fragment. 

 

Fig. 4.27. The scale control panel  

•  - keeps the first crossfade in the center of the screen while scaling. 
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•  - keeps the second crossfade in the center of the screen while scaling. 

•  - keeps the middle of the project in the center of the screen while scaling. 

•  - switches on storing of scale value. 

4.3.3 The tracks control panel 

 

 

Fig. 4.28. The tracks control panel 

•  - Add new track in the project. 

• - Remove selected tracks from the project. 

• , , ,  - Show 1, 2, 3 or 4 tracks of the project on the screen 
correspondingly. 

•  - Show all tracks of the project on the screen. 

•  - drop down list of selection of a number of tracks of the project displayed 
on the screen. 

•  - Show all hidden tracks. 

•  - Hide selected tracks. 

•  - Move selected tracks upwards on the screen. 

•  - Move selected tracks downwards on the screen. 

4.3.4 Playback control panel  

 

Fig. 4.29. Start of playback panel  

•  - Start playback. 

•  - Pause. 

 

Fig. 4.30. Playback mode control panel 

•  - Playback mode from an active marker. Playback begins from a position 
of an active marker and comes to end at the end of the project. 

•  - Playback mode up to an active marker. At start the position of playback is pre-
rolled relative to an active marker on pre-roll duration; playback lasts up to a 
position of an active marker. 

•  - Playback mode between green and red markers. 
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•  - Playback mode with exclusion of a fragment between green and red markers. 
At start the position of playback is pre-rolled relative to a green marker on pre-roll 
duration; playback lasts up to a position of a green marker, then jumps on a 
position of red one and lasts up to the end of the project. 

•  - Playback mode around an active marker. At start the position of playback is 
pre-rolled relative to an active marker on pre-roll duration; playback proceeds 
beyond 
a position of an active marker on the same pre-roll duration. 

•  - Playback mode on a ring. 

• - Playback mode play after removal. If this mode is switched on, BCS Editor 
after removal of a fragment between green and red markers automatically starts 
playing back around a place of removal for quality control of the executed 
operation. 

• - Dropped down lists for setting of pre-roll duration (the first list; 
available values are: 1, 2, 3, 5, 7 and 10 seconds) and automatic crossfade 
between segments (the second list; available values are: 0, 5, 10, 20, 30, 50, 100 
and 200 ms). 

•  - Playback mode: play after moving markers. If this mode is switched on, BCS 
Editor after executing of markers moving automatically starts playing back around 
a new position of a marker for the control of accuracy of positioning. 

• - Playback mode: to stick together insert marker and marker of beginning 
of playback. If this mode is switched on, markers of an insert and beginning 
of playback (blue and yellow markers) are considered joined. 

•  - Playback mode monitoring playback marker. If this mode is switched on, the 
waveform while playback moves on the screen in such a way that the position 
of playback is always visible. 

 

Fig. 4.31.The Shuttle 

• Shuttle - provides playback in both directions with variable speed. Set the cursor 
on red rhomb, press and hold the left button of the mouse. Pressing the button 
starts playback from a position of an active marker. Position "0" corresponds to a 
nominal speed. Moving the mouse to the right increases playback speed; to the 
left – the reproduction in the opposite direction begins. After releasing mouse 
button, red rhomb moves to "0" and playback stops. 

4.3.5 Level adjustments panel 

 

Fig. 4.32. Level adjustments panel 

•  - Displaying of a level between markers with the help of the level indicator. 
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•  - Displaying of a segment level with the help of the level indicator. 

•  - Displaying of a track level with the help of the level indicator. 

•  - Displaying of a level of all tracks (master - level) with the help of the level 
indicator. 

•  - Displaying of volume with the help of the level indicator. 

4.3.6 «Rubber string» mode panel 

 

Fig. 4.33. «Rubber string» mode panel 

•  - Displaying of level adjustment with the help of "rubber string”. 

•  - Mode of setting of nodes of "rubber string”. 

•  - Remove all nodes of "rubber string” on a section between markers. 

•  - Remove all nodes of "rubber string”. 

•  - Apply to the project all changes made with the help of "rubber string”. 

4.3.7 The record panel 

•  - Displaying of the record board. 

 

Fig. 4.34. The record panel 

•  - Area of displaying of record duration. After start of recording the 
indicator is displayed as white figures on a red background. 

•  - Switching on of record. After start of record the button changes color to red. 

•  - Record pause. Repeated pressing of the button starts record again. 

•  - Insert record mode. 

•  - Rerecording mode. 

•  - Mixing mode. 

•  - Pre-roll record mode. 

•  - the dropped down list for selecting of pre-roll duration (it is meaningful at 
the mode of recording with pre-roll switched on). 

•  - record format information field. 
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•  - record format select button. 

•  - hard disk free space information field. Remember, that the 
volume of free space depends of selected record format. 

4.4 BCS Editor settings 
Before describing purposes and settings of specific items, we describe structure of 
parameters 
of BCS Editor application and DIGISPOT® II system as a whole. 

All parameters defining work of the program can be divided into three groups: 

• Parameters specific only for the given copy of the program (BCS Editor); 

• General parameters for different programs set on one workstation (for example, 
BCS Editor and DJIN, DJIN and DDB, etc.); 

• General parameters for all workplaces of the DIGISPOT® II complex. 

Strict separation of parameters allows to simplify settings of entire system and to avoid 
mistakes of wrong interpretation of elements in the settings of different workplaces. 

In the given manual those parameters which have the direct relation to BCS Editor are 
described only; about all other settings read in the detailed description of DJIN application 
of DIGISPOT® II system. 

NOTE 

All settings should be carried out only by qualified personnel. Installation of not optimum 
parameters 
of the program can cause deterioration of work of BCS Editor. 

4.4.1 Configuring presets of saving  
4.4.1.1 Configuring presets of saving of the project 

The presets of saving of the project in a file configuration window (fig. 4.35) can be opened 
with the help of the Edit FILE save presets command of the Presets subgroup of the File 
menu. 

• Preset name - name of preset in the system. 

• The Destination group of parameters - configures a path of saving of files. 

o Enable change destination path - resolves to the user editing of a path of 
files saving (only for saving in a file, at saving in database it is automatically 
blocked). 

o Enable change file name - resolves to the user change the file name at 
saving. 

o Enable to overwrite - allows to the user to rerecord a new material over old 
one. 

o Enable Save As - resolves to the user the saving with another name (in 
another format with another properties). 

• Properties - this group of control elements allows the user to set values by default 
for Type, Category, Artist, Author properties of a material and to allow or forbid 
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change of their values (flags Enable to modify and the button « In addition … » 
(Enable change additional item properties (More Details … button))). 

• Audio format- this group of elements allows to set an audio format by default, and 
also to allow or forbid its changing by the user (flag Enable to modify). An audio 
format is meant as a way of its coding: without coding (PCM), MPEG Layer 2, MPEG 
Layer 3, and also digitization frequency and parameters of a stream (bitrate). 

 

 

Fig. 4.35. Configuring presets of saving of the project in a file 

• Audio File Format- this group of parameters determines a format of a file, in 
which material will be kept. The Enable change file type flag determines, whether 
it is allowed to the user to change a file format while saving. 

• Set playback level while saving to DB or WAV (dBFs) - automatically brings 
the volume level of saved material to the set value. The given command works only 
at audio export. 

In the Presets subgroup of the File menu there is one more command for presets 
setting - Edit DB save presets, opening the window Save project to DB presets (fig. 
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4.36). The only difference of the given window from described above is the blocked field 
Destination, since 
at saving in MDB the location of a file is determined by MDB adjustments. 

4.4.1.2 Configuring presets of saving of the subject 

At the Presets subgroup of commands (enclosed menu Advanced of the File menu) two 
more additional items are present, allowing to work with presets – this is Save subject to 
file presets and Save subject to DB presets. 

 

 

Fig. 4.36. Configuring of presets of saving of the project in MDB 
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Fig. 4.37. The Save subject to file presets window 

 

Fig. 4.38. The Save subject to DB presets window 

Save subject to file presets command opens the Save subject to file presets 
window (fig. 4.37). The Save subject to DB presets command (located in the same place) 
opens the similar window Save subject to DB presets (Fig. 4.38) which differs from 
previous screen 
in blocked Destination field. 
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Parameters of both mentioned windows are similar to parameters located in the Save 
project to FILE presets window (fig. 4.35); they are described above. 

 

 

Fig. 4.39. The Schedule window tab of the Setting window 

4.4.2 The Settings item of the Service menu 

Service → Settings command opens the Settings window in which setting of parameters 
of the concrete application is made (in this case BCS Editor). Settings window contains the 
following tabs: Schedule window, Other, Toolbars and Language. We consider the 
assignment of elements of the listed tabs. 

4.4.2.1 The Schedule window tab 

• Add object to DataBase before inserting to the schedule flag activates 
settings of the Schedule window tab, responsible for automation of addition of 
items to MDB and to the schedule of the DIGISPOT® II system. 

• The group of parameters Type and category of new objectallows to establish 
properties of new element of MDB. 

o The Show ‘Add new object’ dialog) parameter allows the user to select 
individual parameters for each element added in MDB. 

o Automatically add objects to specified type and category- automates the 
process of addition of elements with the help of preset parameters Type of 
new object, Designate to the category)and Generate category name. 
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• Group of parameters Name of new object is responsible for generating of the 
name of a new element in MDB and does not need additional explanations. 

4.4.2.2 The Other tab 

This tab includes parameters grouped due to destination relating to various modules of BCS 
Editor. In the given section most important of them and most frequently used will 
be considered. 

The most part of settings accessible from this window, is crossed with similar settings 
of DJIN on-air application of DIGISPOT® II system (they can be found on tab Other of the 
Settings window, opened with the help of the same command of the Service main menu); 
they are described in the DJIN manual. The sense of many parameters is obvious from the 
name and does not need additional explanations. 

 

 

Fig. 4.40. The Other tab of the Settings window  

• Interface - settings of the interface of DIGISPOT® II system applications. This 
group contains a set of parameters changing behavior of the program while working 
with the main window of audio editing. Names of parameters clearly enough 
determine their assignment. 

• Audio files marking - this group of parameters determines algorithm of automatic 
search of a start point. 

• Text - in this group values of the parameters used for display of the text in viewing 
windows are set; here the Reading speed (char/min) parameter is set, 
responsible for approximate estimation of reading text time. 
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• Base settings - in the given group of parameters setting of programs of the 
DIGISPOT® II system, concerning directories of file storage, is concentrated. In 
the given subgroup only two parameters concern to BCS Editor: 

o Fragments storage directory- determines the directory in which projects 
and the subjects displayed in the list of the Fragments window are kept. 

o Storage for editor temporary files - determines a place of storage 
of all temporary files. 

• Debug Logs (restart needed) - the group of parameters responsible for 
recording 
of system logs. Parameters of this group are important for debugging of 
DIGISPOT® II system and more often are not required in the further work with 
applications. 

• Schedule - parameters of settings of the Schedule module (are similar 
to parameters of the DJIN application). 

• External programs - is the group of parameters, controlling start of external 
applications on the fact of start and closing of the BCS Editor. 

• Audio editor - is the group of parameters concerning entirely and completely to 
the BCS Editor. 

o User interface - specific parameters of the user interface of the BCS Editor. 
The most important in this group are: 

� Show ‘Open files' dialog for new tracks - the setting allowing to create 
a new track automatically while loading of a sound. 

� Segment node capture range - determines the radius, at hitting in which 
the mouse cursor is considered taking place «on a node». It matters while 
working 
in the «rubber string» mode. 

� Activate segment - separate operation - this parameter selects an 
activation of a segment in separate operation. For time economy is more 
conveniently 
to switch it off. 

� Mouse wheel subgroup - determines work with the mouse in BCS Editor. 

� Start play when PFL mode changed - this parameter allows to switch 
on playback automatically at changing a type of listening. 

� Parameters Set act marker to start play position on dbl. click, Follow 
play marker, Activate marker automatically expand opportunities of 
work with markers and do not need additional explanations. 

� Auto crossfade, Save auto crossfade last value - these parameters set 
the size of automatic crossfade and necessity to save the set value. 

� Playback preroll, Save playback preroll - these parameters set the size 
of preroll and necessity to save the set value. 

o Shuttle - this group determines playback parameters in shuttle and jog modes 
(they are accessible only in case of presence of hardware support changing 
playback speed); here it is possible to set minimal and maximal speed, their 
initial value, and also a step of change. 
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o Default Project Settings – there is properties of the project by default. 
Parameter Set edit step for mp2 blocks sets the size of the block while work 
with MP2, and the Record gain item determines recording level value by 
default. 

o Crossfade editor – are specific parameters of the crossfade editor. 

• Audio files – are parameters for reading audio files. 

• Prelistenning – are parameters for prelistenning of elements, for example, in the 
Subject window. 

• Copyright registration – are parameters of the copyrights registration, set for all 
programs of the DIGISPOT® II system. 

• Audio devices – are parameters of used audio-devices. 

• Parameters of the audio reserving system – is the group of characteristics 
of reserve system of the DIGISPOT® II. 

• Skeletons – is a set of parameters of the Skeletons module of the DIGISPOT® II 
system. 

• Voice track – are parameters of the module of voice tracks recording of the 
DIGISPOT® II system. 

• Files – are parameters of the Files module of the DIGISPOT® II system. 

• Media DB – is the parameter Double click action of the MDB module of the 
DIGISPOT® II system. 

4.4.2.3 The Toolbars tab 

Two lists, located on the given tab (fig. 4.41), control logic of an arrangement of windows 
of modules of BCS Editor on the screen: Data Base, Schedule, Files and Fragments 
buffer. 
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Fig. 4.41. The Toolbars tab of the Settings window 

4.4.2.4 The Language tab 

Parameters located on this tab, allow changing the language of the interface (fig. 4.42). 

 

 

Fig. 4.42. The Language tab of the Settings window 

4.4.3 The Global settings item  
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of the Service menu 

The given settings are general for all applications of the DIGISPOT® II system on all 
workplaces. Their change on one workplace results in changes on all other workplaces. 
Usually setting of these parameters is carried out once at configuration of entire system and 
further does not vary. 

Detailed information on the parameters set in the Global settings window, is given in 
the DJIN manual of DIGISPOT® II system where we recommend addressing for additional 
information. 

4.4.4 Workstation settings 

The Workstation settings command of the Service menu opens the Workstation 
settings window, unified for all applications of the DIGISPOT® II system (fig. 4.43). The 
detailed description 
of the parameters set in this window is given in DJIN manual. 

 

 

Fig. 4.43. The Other tab of the Workstation settings window 

 

Fig. 4.44. The Customize keyboard and remote keypads window (the list is reduced) 

4.4.5  Customize keyboard settings 
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This window lists functions and commands accessible with the help of hot keys from the 
keyboard. It is similarly possible to adjust commands of remote control (GPI or RS 232), 
of course, if remote control is present in your setup. 

 

 

Fig. 4.45. The Customize keyboard and remote keypads window (the list is dropped-down)  

 

Fig. 4.46. The Edit key window 

Adjustments of the keyboard and remote control, as well as many other windows, are 
standardized for all applications of DIGISPOT® II system (fig. 4.44, 4.45, 4.46). More 
details about adjustments of keyboard hot keys are given in the DJIN manual. 

4.4.6 Fonts settings 
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The Fonts command of the Service menu opens the Fonts setup window. In this window 
you can change the fonts used in various windows of BCS Editor. In the moment there 
is an opportunity of only two parameters adjustment: fonts of the Segments list and 
Category and attribute list. 

In the Name column of the Fonts setup window the name of a field of a window of the 
program is displayed, and in the Font column the type of the font set for it. By double click 
on a line with the necessary name of a field the standard window of fonts setting where 
is possible to select type family, size and other attributes of the text opens. By pressing Ок 
the changes made in a window, are saved. By selection Cancel all changes are neglected. 

4.4.7 Mixers  

The Mixers item of the Service menu repeats the Audio mixers item of subgroups 
of Hardware devices commands of the menu Service in DJIN application. These commands 
both open the Mixer controls setup window, described in details in DJIN manual. 

4.4.8 Administration of the BCS Editor 

All applications of the DIGISPOT® II system are joined by the uniform administration service 
not accessible for common users. In details the administration system is described enough in 
the DJIN manual. 

4.5 Properties of BCS Editor objects 

4.5.1 Project properties 

The Project properties command of the Project menu opens Project the Properties 
window, allowing to set some parameters of created material: its name, the author and the 
artist 
(fig. 4.47). It is possible to note comments concerning the project on the second tab. Other 
parameters of this window are not subject to change. 

 

 

Fig. 4.47. The Properties window 

While saving the project you can take advantage of the extended window of properties 
of MDB elements of the DIGISPOT® II system. It is possible to open the extended 
Properties window with the help of the More details button, located in the Save project to 
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FILE window, Save project to DB window, Save subject to FILE window and Save 
subject to DB window. 

The extended Properties window allows describing the project, in other words, to add 
or change its metadata; its storage place both in file structure, and in MDB. The Properties 
window has five tabs: General, Attributes, Remote control, Comments and Other. 

 

 

Fig. 4.48. The extended Properties window, tab General 

The General tab allows specifying the name and address of a file in file system, and 
also parameters of its indexation in MDB (ID Number and DB ID) and a format of an audio 
file 
of the project. Here such parameters, as Artist, Author, Version, Type, Sort, Category, 
Media, Album, Track, Jingle ID and belonging to this or that radio station are specified. 

You can set markers of rotated element on this tab, of the voice track, of playing 
of an audio track in a loop (with editing of time of playing) of entire audio track or so-called 
outro, change to the next on finishing, etc. On the General tab the user has an opportunity 
to set an airing time for broadcasting station and to enter First line and Last line 
parameters, facilitating work in the mixed text-sound environment (for example, you can 
use first and last lines of the report). 

The Attributes tab (fig. 4.49) allows to select and specify different user attributes of 
MDB element for the given project, thus to extend its metadata. 
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Fig. 4.49. The extended Properties window, the Attributes tab 

With the help of the Remote control tab (fig. 4.50) you can create commands and 
attach them to the chosen elements of the schedule (in this case - to the project of BCS 
Editor). For example, we can create a command for switching on / off of a panel during action 
of the «Microphone insert» element of the schedule, give start playback to the tape recorder 
on a pause inserted in the schedule, i.e. to provide its filling with an external source, to give 
a command for switching to the router when changing for retransmission and many other 
things. Actual implementation of this command can be rather various, the main thing that in 
the certain moment of time on a certain port of broadcasting station the certain signal 
appears which can be interpreted and transformed to GPI or other form for performance of 
the planned action. 

 

 

Fig. 4.50. The extended Properties window, the Remote control tab  

Addition and creation of commands is made with the help of the context menu of the 
list. More details about it are given in DJIN manual. 

Comments tab (fig. 4.51) allows you to type your own notes which will be attached 
to an audio track. It is possible to read this comment only in the same window. 
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Fig. 4.51. The extended Properties window, the Comments tab 

The Other tab (fig. 4.52) contains specific parameters of MDB DIGISPOT® II 
elements: parameters of readiness of the project to broadcasting and belonging of it to an 
archive. 

 

 

Fig. 4.52. The extended Properties window, the Other tab 

More details about these and other parameters of the extended Properties window 
are given in DJIN manual. 

4.5.2 Audio track properties  

The context menu of a zone of indication and setting of the project duration includes the 
Track properties command, which opens the same window (fig. 4.53), allowing to set 
properties 
of each audio track separately. 
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Fig. 4.53. The Track properties window 

It allows setting the name of a track and individual parameters of the waveform 
appearance. 

4.5.3 Fragments window properties 

The elements entered in the Fragments window, as well as projects themselves, have their 
own metadata. You can edit them in the Properties window, opened with the help of the 
context menu of an element of the Fragments window. The given window is identical to the 
Properties window of the project (not extended); more details about the parameters 
accessible for editing, are given in section 4.5.1. 

4.5.4 Audio insert properties in the Subject window 

As well as elements of the Fragments window, audio inserts have their own metadata in 
the Subject window. You can edit them in the Properties window which is opened with the 
help 
of the context menu of audio insert. 

The given window has four tabs: General, Comments, Marking and Other, three 
of which General, Comments and Other are identical to the same tabs of the extended 
Properties window of the project (for more details about these tabs address to section 4.5.1 
of the given manual). 

The Marking tab repeats the same tab of the Properties window of the DJIN 
application. For more details refer to DJIN manual. 
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